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SolidWorks Installation and
Administration Guide

This guide describes installation, licensing, upgrading and administration of SolidWorks
products for both individual installations and multiple installations.

Deploying Multiple InstallationsIndividual Installations

Installation

Creation of an administrative image that is
deployed to a number of client computers.

Installation

Installation on one or a few computers.

Licensing

License activation or network licensing.

Licensing

License activation or network licensing.

Upgrades

Moving multiple computers to a new release
by updating the administrative image used
to install on those computers.

Upgrades

Moving individual computers to a new
release.

Administration

Network licensing administration, services,
Workgroup PDM, vault administration, and
so on.

Administration

Service packs, modifying, and so on.

SolidWorks Installation Manager enables you to configure settings for SolidWorks product
components, including SolidWorks, SolidWorks Toolbox, PhotoView 360, Workgroup PDM,
and SolidWorks SolidNetWork License Manager.

Workgroup PDM is project data management software that runs inside the SolidWorks
environment or as a standalone application inside SolidWorks Explorer. Workgroup PDM
controls projects with procedures for check out, check in, revision control, and other
administration tasks.

SolidNetWork License Manager supports multiple license clients by distributing licenses
to clients on the network. This allows the number of users to exceed the number of
licenses by using floating licenses.

Individual Installation or Administrative Image
Should you install SolidWorks products on each computer individually, or should you
create an administrative image and deploy the installation to all clients with one command?

5



If you are installing on only one computer, or if you manage dozens or hundreds of
computers, the choice is obvious. For situations in between, consider the following
comparisons.

Administrative imageIndividual installation

The system administrator can customize
multiple installations using the Option
Editor, specifying installation options such
as creating a new installation or updating
an existing one, running the installation as
an administrative user, running external
commands before or after the installation,
different product groupings, and so on.

Users can do their own SolidWorks
administration.

Client computers can be distantly located
as long as they are accessible from the
same network.

The computers must be physically accessible
to the person performing the installation.

Using the Option Editor, administrative
images can maintain consistency in
versions, service packs, products, and
settings for multiple installations.

You can install different versions, service
packs, or products on different computers,
with independent settings.

Media drives are not required when applying
service packs.

The original source media (DVD) is required
when applying service packs.

A local network connection is required to
deploy the application; media drives are not
required on client computers.

The computer does not need to be on a
network.

Clients can be updated automatically. All
clients deployed from the same
administrative image are at the same
service pack. To maintain multiple versions,
you can create multiple administrative
images.

License activation can be automated.

An administrative image requires additional
disk space on the server; clients require the
same space as individual installations.

Initiating SolidWorks Installation
You can initiate SolidWorks installation from loading a DVD on the local computer,
accessing a shared installation directory, or downloading from SolidWorks.

To initiate SolidWorks installation, do one of the following:

• To install on a local computer from disk, insert the appropriate disk into the
computer's disk drive.

• To install from a download directory, navigate to the directory and double-click
setup.exe.

• To install by downloading from SolidWorks:
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1. Browse to the SolidWorks Web site.
2. Login as a Subscription Service Customer, using your email address and
password, or your SolidWorks serial number.

3. Under Self Service, click Download Software and Updates.
4. Under Download Software, select the SolidWorks version and service pack
to download.
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Individual Installations

Installation on Individual Computers
You can install SolidWorks on an individual computer using several installation methods.

The SolidWorks Installation Manager performs the installation, tailoring the installation
to the products you have purchased. Before you start the installation:

• Have your SolidWorks serial number available.
• Verify that you have a working internet connection.

SolidWorks Installation Manager requires various Microsoft components, including
Microsoft Windows Installer, Office Web Components, Microsoft Visual Studio Tools
for Applications, and .NET Framework. If the correct versions of all Windows
prerequisite components are not installed on the computer, SolidWorks Installation
Manager installs them automatically prior to installing SolidWorks products.
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Summary of the ProcessInstallation Method

Insert the appropriate DVD disk into the computer
disk drive.

Using the SolidWorks installation
media

The SolidWorks installation media provides
separate DVDs for 32-bit and 64-bit Windows
installations.

In the download directory, double-click setup.exe.

The download directory must be accessible from the
computer on which you are installing SolidWorks

Using a download directory on a
server

products, and it must contain all of the SolidWorks
installation files before installation can begin.
Installation Manager can help you find missing files
if you have internet access and write access to the
download directory.

This is not an administrative image. The only
way to install a client computer from an
administrative image is by clicking the link in
the HTML page distributed by the SolidWorks
administrator.

Do one of the following:Updating an existing SolidWorks
installation using Check for
Updates

• In SolidWorks, click Help > Check for Updates.
• In Windows, click Start > All Programs >
SolidWorks Installation Manager > Check for
Updates.

In either of the previous methods, you can schedule
a regular check for updates by selecting Check for
Updates every X days and then specifying a value
between 1 and 99.

You must have a working internet connection.

Workgroup PDM clients detect Vault updates
automatically. You do not need to download a
service pack to update clients. For details, see
Update Clients in the Workgroup PDM online
help.

9



Summary of the ProcessInstallation Method

1. Browse to the SolidWorks Web site.
2. Login as a Subscription Service Customer, using
your email address and password, or your
SolidWorks serial number.

3. Under Self Service, click Download Software
and Updates.

4. Under Download Software, click the SolidWorks
version you wish to install.

You must have a working internet connection.

You must be a Subscription Service Customer
with login access to the Customer Portal site.

Downloading from the SolidWorks
customer Web site.

When the installation is complete, start the SolidWorks application and activate the license.

Administration of Individual Installations
Typically, administration of individual installations consists of modifying, repairing,
removing, and upgrading installations.

Modifying an Installation
You can modify an installation to install products that have not been installed or to remove
products.

If you installed SolidWorks and purchased an add-in at a later time, you can modify the
installation to include the new add-in. You must install the add-in on each individual
machine.

Workgroup PDM is not installed if you are modifying your original SolidWorks package
to include SolidWorks Professional or SolidWorks Premium.

1. Make sure no SolidWorks sessions are active.
2. In Windows, open the Control Panel and run Add or Remove Programs.
3. Select the SolidWorks installation you want to modify and then click Change.
4. On the Welcome screen, ensure that Modify the individual installation (on this

computer) is selected and click Next.
5. On the Serial Number screen, verify that the appropriate serial numbers are specified

and click Next.
6. On the Product Selection screen, select the products to install or remove, and then

click Next.
When modifying an installation:

• No products are installed or removed by default, even if you specify a new serial
number. You must change the installation action of each product or feature.

• To view the projected modification action for a particular component, click the
component name (but not the check box). The intended modification action appears
in the information field below the product listing.
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• To see the available features for each product, click + next to that product and
then click the icon next to the product or feature to change the installation actions.

• When you change a product selection from the initial specification, an asterisk (*)
appears next to that product component in the listing.

7. On the Summary screen, click Modify Now.
8. On the Installation is Complete screen, click Finish.

Repairing an Installation
If you encounter problems with an installed SolidWorks Product, you can use the
SolidWorks Installation Manager to repair the installation.

You can repair an individual installation. You cannot repair an administrative image;
you must uninstall and then reinstall the administrative image.

1. Click Start > Control Panel > Add or Remove Programs.
2. Select the SolidWorks version you wish to repair and click Change.
3. On the Welcome to SolidWorks Installation Manager screen, click Repair this

installation.
4. On the Products to Repair screen, select the product to repair.
5. Clear the rest of the products on the screen.
6. Click Repair.

Rolling Back an Individual Installation to a Previous Service Pack
To roll back an individual installation to a previous service pack release in the current
major release family, uninstall the service pack version currently installed on the computer
and then re-install the earlier version.

Removing an Installation
You can remove an installation on an individual computer or in a client/server environment.

1. Make sure no SolidWorks sessions are active.
2. If you wish to transfer the SolidWorks license to another computer, transfer the license

to that computer before removing the SolidWorks installation on this computer.

For information about transferring SolidWorks licenses, see Transferring a License
on page 56.

3. In Windows, open the Control Panel and double-click Add or Remove Programs.
4. In Add or Remove Programs, select the product component to remove.

In some cases, you might find multiple SolidWorks Service Pack components
for a given major release version. To remove a SolidWorks major release, remove
all Service Pack elements for that major release in Add or Remove Programs.

5. Click Remove.
6. In the SolidWorks Installation Manager, on the Products to Remove screen:

a) Select the products to remove.
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By default, all product components are selected.

b) Clear the products you do not want to remove.
c) Click Remove Items.

Upgrading to a New Release
There are several methods for upgrading an individual installation to a new SolidWorks
release.

You can upgrade to a new release when you:

• Receive new installation media
• Are notified of upgrades when starting SolidWorks
• Check for updates manually
• Start a new instance of Installation Manager

When installing a new major release, you can upgrade a previously installed major release
or install the new release in parallel. If you are installing a Service Pack release for a
previously installed major release, that release is updated automatically.

Checking for Updates Manually
You can check for updates for a currently installed SolidWorks release using one of these
methods.

• In SolidWorks, click Help > Check for Updates.
• In Microsoft Windows, click Start > All Programs > SolidWorks Installation
Manager > Check for Updates.

You can also schedule a regular check for updates. Using either method, in the dialog
box that displays, select Check for Updates every X days, and specify a value, where
X can be between 1 and 99.

Upgrading Workgroup PDM Clients
Workgroup PDM clients detect when the Vault has been updated. You do not need to
download a service pack to update clients.

For instructions, see Update Clients in the Workgroup PDM online help.

Upgrade Caveats
Products that can have multiple installations with different major versions do not always
support major upgrades, or the ability to upgrade between major versions as a single
operation.

In this case, the Installation Manager simulates the upgrade by first installing the new
version, then removing the old one. At this time, the core SolidWorks product and
DWGeditor support major upgrades, while the other products do not.

The consequences of this are:

• When upgrading the core SolidWorks product and DWGeditor between major versions:

• Your existing installed locations do not change.
• The upgrade can be rolled back if an error occurs or the you cancel during the
upgrade.

• When other products are upgraded between major versions:
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Each product is first installed as a new product to a new location, then the original
installation is removed.

•

• Once started, the upgrade cannot be rolled back if an error occurs or if you cancel
during the upgrade.

Product Coexistence Rules
These product coexistence rules determine how new products are installed and existing
products are upgraded.

ExamplesRule

SolidWorks 2009 SP3.0, and SolidWorks
2010 SP0.0 can coexist on the same
computer.

However, if SolidWorks 2010 SP0.0 is
installed on a computer, and you install
SolidWorks 2010 SP1.0, Installation
Manager replaces the SP0.0 version with
the new SP1.0 version.

SolidWorks 2010 SP0.0 and 2010 SP1.0 will
not coexist on the same computer.

Multiple major release versions of a core
SolidWorks product are allowed, regardless
of service pack or major release (with the
exception of the three products mentioned
below).

If SolidWorks 2010 SP0.0 is installed,
DWGeditor is upgraded to 2010 SP0.0, even
if an earlier major release of SolidWorks
remains on the computer.

Only one version of the following products
is allowed on the computer:

• DWGeditor
• Workgroup PDM Server
• SolidNetWork License Manager

If SolidWorks 2010 SP0.0 is upgraded to
2010 SP1.0, SolidWorks Explorer 2010
SP0.0 will automatically upgrade to 2010
SP1.0. However, SolidWorks Explorer 2009
SP4.0 can also exist on the computer.

Only one version of an included product can
be installed for any major version.
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Multiple Installations

Deploying to Multiple Clients
You can install the SolidWorks product on multiple clients by creating an administrative
image and then deploying the installation to clients.

The process for deploying to multiple clients is:

1. Create an administrative image.

• Creating an Administrative Image from the Installation Manager on page 14
• Creating an Administrative Image from the Command Line on page 19

2. Deploy the administrative image to clients.

• Deploying an Administrative Image to Clients Through Email on page 19
• Installing from the Administrative Image Using the Command Line on page 28

3. Implement licensing.

• Administering Individual Licenses on page 55
• Administering Licenses Using a SolidNetWork License Manager on page 56

Using Administrative Images
An administrative image allows configurable installations of SolidWorks products from a
single network location.

You can install the administrative image from any computer on the network, including a
client computer.

• The administrative image must be in a shared folder.
• If you include all products, the administrative image disk space requirements can be
7GB or more.

• If you update the share name when you upgrade the administrative image, the client
upgrades automatically the next time the application is started. For details, see
Upgrading Clients from Administrative Images on page 44.

• Clients must have administrative privileges on their computers, unless the Run the
installation as a different user option is specified for the client installation in the
Administrative Image Option Editor on page 15.

This option is not supported on Windows Vista or later.

To manage groups of users with multiple products and serial numbers, see Administrative
Image Option Editor on page 15.

Creating an Administrative Image from the Installation Manager
If you are installing SolidWorks on multiple computers, you can create an administrative
image and then deploy the application to other computers.
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1. Start SolidWorks Installation Manager (as described under Initiating SolidWorks
Installation on page 6).

2. On the Welcome screen, select the following:

• Administrative Image and Server products
• Create or update an administrative image.

3. Follow the on-screen instructions.

Administrative Image Option Editor
The Administrative Image Option Editor lets you customize installation parameter settings
in an administrative image for individual machines and for groups of machines.

After creating an administrative image, the Installation Manager asks you to start the
Option Editor. You can also start the Option Editor by double-clicking
sldim\sldadminoptioneditor.exe in the administrative image folder.

To specify different installation configurations for groups of machines or individual
machines, add groups and machines in the Option Editor and then specify the installation
options for those groups and machines.

Adding and Deleting Groups and Machines
The Administrative Image Option Editor lets you specify different installation configurations
for groups of machines and for individual machines.

For example, you might want to configure several machines to use a particular subset of
the product components available in the image while another group might use a different
subset of product components. Even though you are using one administrative image, the
Option Editor group settings enable you to install different product subsets to different
groups of machines.
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To add a group:
1. Right-click Global Settings and then click Add

Group.
2. Enter the group name.

To add machines:
1. Right-click an existing group or Global Settings
and then click Add Machine.

If you right-click an existing group, machines
are added to that group. Otherwise, they are
added at the top level.

2. Do one of the following:

• Enter one or more machine names under
Machine Name.

Multiple machines can be separated by a line
break, space, tab, comma, period, colon, or
semi-colon. You can copy and paste a list of
machine names from an external file.

Machine names cannot include domain qualifiers.
For example, pluto.solidworks.com is invalid.

• Click Add Multiple Machines to select machines
from the network.

Drag the machine onto the group.To move an existing machine to
a group:

Drag the machine onto Global Settings or onto a
different group.

To move a machine out of a
group:

Right-click the group or machine and then click Delete
Group or Delete Machine.

To delete a group or machine:

If you delete a group, all machines within that
group are deleted.

Right-click Global Settings and then click Delete All.To delete all groups and
machines:

Specifying Option Settings for Groups and Machines
You can specify option settings for all machines, groups of machines, and individual
machines.
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Option settings are inherited as you move down the hierarchy. For example:

• Settings defined for Global Settings are inherited by all groups and machines.
• Settings defined for a group are inherited by all machines within that group.

You can change option settings for a machine or group to override default or inherited
settings. When you change an option setting from the default or its inherited value, that
option is highlighted.

To revert option settings to the original inherited values, right-click the group or
machine and then click Revert to Global Settings (for a group or machine that is
not a group member) or Revert to Group Settings (for a machine that is a group
member).

To specify option settings:

1. Click the object to modify (for example, Global Settings, a group, or a machine).
2. On the tabs to the right, specify the option settings.
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Option settingsOption tab

Enter serial numbers for the various products to install.

Specify the port and server for a SolidWorks Network
License (SNL) Server. For details, see Network License
Overview.

Serial Numbers

Create a new installation or to upgrade the most recent
existing installation.

Specify the installation directory on the client machine.

Use the default SolidWorks user interface settings
(keyboard shortcuts, menu customization, toolbar layout,
and so on) or use settings saved from another installation
using the Copy Settings Wizard.

Choose whether to participate in the SolidWorks
Customer Experience Program. For further information,
see the Customer Experience Feedback Program Web
site.

Client Options

Automatically activate client installations. For details,
see License Activation.

Create a diagnostic log during installation.

Run the installation as a different user (for example, if
administrative permission is required for installation).

Image Options

Installing the administrative image on the client by
using a mapped drive (instead of a UNC Format on
page 99) can fail if this option is specified, due to
remote permissions problems.

This feature is not supported on Windows Vista or
later.

Run external programs before or after the installation.

Specify the product components to install.Software to Install

Use existing standard Toolbox library files or install new
library files.

Standard Libraries

3. Close the Option Editor to apply changes in the option settings.
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Deploying an Administrative Image to Clients Through Email
Once you have created a shared administrative image directory, you can notify clients
by email.

Configure the administrative image directory to be shared on a machine that is accessible
to other computers (for example, through a UNC Format on page 99).

You can send an email containing a link to
admin_image_install_dir\StartSWInstall.hta to all clients. Clients would then open
the file and click Install SolidWorks products now to start the installation from the
administrative image.

If you are upgrading an administrative image to a new SolidWorks version, you can
configure your administrative image location and share properties so that any clients
that installed previously using that image will upgrade automatically. For details,
see Upgrading Clients from Administrative Images on page 44.

Advertising an Administrative Image to Clients
You can run a command to advertise a new administrative image installation to clients.

Email deployment is the method generally used to notify clients of a new SolidWorks
installation.

However, as an alternative, you can execute a command to advertise a new installation
to clients. For example, you might advertise to employees who do not normally use the
SolidWorks application.

Advertising SolidWorks creates a shortcut to the SolidWorks application on the Start
menu on the user's computer and creates a file association with the administrative image
on the server. Initially, the executable files are not installed. Installation occurs only when
the user first needs the application.

When the user clicks the shortcut or double-clicks a SolidWorks document, the installation
begins and the SolidWorks application executes.

To advertise from an administrative image:

1. Create and configure the administrative image.
2. Advertise the product on each machine where the SolidWorks application is to be

installed.
For example:

msiexec /jm path_to_msi_file_of_admin_image

where path_to_msi_file_of_admin_image is a UNC Format on page 99 to the
administrative image directory.

Command-Line Deployment
You can automatically deploy an administrative image using a command prompt or batch
file (silent installation).

Creating an Administrative Image from the Command Line
You can create an administrative image using the Installation Manager or from the MS-DOS
command line. The command line allows you to customize the installation.
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If you create an administrative image from the command line, you must create and
deploy a MSI File Locations for Administrative Images on page 39.

1. Open a Command Prompt window.
a) In Windows, click Start > Run.
b) Enter cmd and click OK.

2. Enter this command:
msiexec /a Msi_path

where Msi_path is the path and filename of the .msi file for your operating system.
The SolidWorks.msi is located in the swwi\data subdirectory in the installation
directory.

For example:

msiexec /a F:\swwi\data\SolidWorks.msi

3. In the SolidWorks Setup Wizard, follow the on-screen instructions.

Preparing Clients for Command-Line Installation from an
Administrative Image
After creating the administrative image and before notifying clients, you must install
Microsoft Windows components that cannot be installed by administrative images created
using the command line or Microsoft Active Directory.

Installing these Windows components manually is required only if you are installing
from an administrative image that was created manually using the command line
or through Microsoft Active Directory. If you use the Installation Manager to create
and install the administrative image, these Windows components are installed
automatically.

Here is a summary of the files required by SolidWorks in the Windows components:

Contains files needed to run the installation of
SolidWorks Simulation Premium.

Windows Installer

Contains COM controls that are needed for DriveWorks.Office Web Components

Contains runtime components for Microsoft Visual C++.Visual C++ 2005 and 2008
Redistributable Package

The 2005 and 2008 versions both must be
installed.

Contains a tool set supporting Visual Studio applications.Visual Studio Tools for
Applications

Provides a debugging environment for 64-bit operating
systems.

Visual Studio Remote
Debugger

Contains the common language runtime and .NET
Framework components that are necessary to run .NET
Framework applications.

.NET Framework 3.0
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Supports fast searches of files and data across different
data sources and locations, including the local computer
and shared networks.

Windows Desktop Search
(optional)

Windows Desktop Search files are language
specific.

Visual C++ Redistributable Package and .NET Framework 3.0 are required for all
SolidWorks products, not just the core SolidWorks product.

These components must be included in subdirectories of the administrative image directory.

This table identifies the specific files that are required for each supported operating system.
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Operating System: Windows 2003 32-bit1

SolidWorks Media: 32-bit version for Windows XP, Windows Vista, and Windows 7

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exeVisual C++ 2005 Redistributable Package:

vcredist_x86.exeVisual C++ 2008 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:

(Not applicable)Visual Studio Remote Debugger:

dotnetfx3.exe.NET Framework:

Windows Desktop Search (optional):

WindowsDesktopSearch-KB917013-V301-Srv2K3-x86-lang.exe

Operating System: Windows 2003 64-bit1

SolidWorks Media: 64-bit version for Windows XP, Windows Vista, and Windows 7

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exe

vcredist_x64.exe

Visual C++ 2005 Redistributable Package:

Both must be installed.

vcredist_x86.exe

vcredist_x64.exe

Visual C++ 2008 Redistributable Package:

Both must be installed.

vsta_aide.msiVisual Studio Tools for Applications:

rdbgexp.msiVisual Studio Remote Debugger:

dotnetfx3.exe.NET Framework:

Windows Desktop Search (optional):

WindowsDesktopSearch-KB917013-V301-Srv2K3_XP-x64-enu.exe

Operating System: Windows 2008 32-bit1

SolidWorks Media: 32-bit version for Windows XP, Windows Vista, and Windows 7

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exeVisual C++ 2005 Redistributable Package:
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vcredist_x86.exeVisual C++ 2008 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:

(Not applicable)Visual Studio Remote Debugger:

.NET Framework 3.0 and Windows
Desktop Search are features of the
operating system.

.NET Framework:

Windows Desktop Search (optional):

Operating System: Windows 2008 64-bit1

SolidWorks Media: 64-bit version for Windows XP, Windows Vista, and Windows 7

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2005 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2008 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:

rdbgexp.msiVisual Studio Remote Debugger:

.NET Framework 3.0 and Windows
Desktop Search are features of the
operating system.

.NET Framework:

Windows Desktop Search (optional):

Operating System: Windows XP 32-bit

SolidWorks Media: 32-bit version for Windows XP, Windows Vista, and Windows 7

WindowsInstaller-KB893803-v2-x86.exeWindows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exeVisual C++ 2005 Redistributable Package:

vcredist_x86.exeVisual C++ 2008 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:

(Not applicable)Visual Studio Remote Debugger:

dotnetfx3.exe.NET Framework:

Windows Desktop Search (optional):

WindowsDesktopSearch-KB917013-V301-XP-x86-lang.exe
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Operating System: Windows XP 64-bit

SolidWorks Media: 32-bit version for Windows XP, Windows Vista, and Windows 7

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exeVisual C++ 2005 Redistributable Package:

vcredist_x86.exeVisual C++ 2008 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:

rdbgexp.msiVisual Studio Remote Debugger:

dotnetfx3_x64.exe.NET Framework:

Windows Desktop Search (optional):

WindowsDesktopSearch-KB917013-V301-Srv2K3_XP-x64-enu.exe

Operating System: Windows XP 64-bit

SolidWorks Media: 64-bit version for Windows XP, Windows Vista, and Windows 7

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2005 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2008 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:

rdbgexp.msiVisual Studio Remote Debugger:

dotnetfx3_x64.exe.NET Framework:

Windows Desktop Search (optional):

WindowsDesktopSearch-KB917013-V301-Srv2K3_XP-x64-enu.exe

Operating System: Windows Vista 32-bit

SolidWorks Media: 32-bit version for Windows XP, Windows Vista, and Windows 7

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exeVisual C++ 2005 Redistributable Package:
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vcredist_x86.exeVisual C++ 2008 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:

(Not applicable)Visual Studio Remote Debugger:

.NET Framework 3.0 and Windows
Desktop Search are features of the
operating system.

.NET Framework:

Windows Desktop Search (optional):

Operating System: Windows Vista 64-bit

SolidWorks Media: 64-bit version for Windows XP, Windows Vista, and Windows 7

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2005 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2008 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:

rdbgexp.msiVisual Studio Remote Debugger:

.NET Framework 3.0 and Windows
Desktop Search are features of the
operating system.

.NET Framework:

Windows Desktop Search (optional):

Operating System: Windows 7 32-bit

SolidWorks Media: 32-bit version for Windows XP, Windows Vista, and Windows 7

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exeVisual C++ 2005 Redistributable Package:

vcredist_x86.exeVisual C++ 2008 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:

(Not applicable)Visual Studio Remote Debugger:

.NET Framework 3.0 and Windows
Desktop Search are features of the
operating system.

.NET Framework:

Windows Desktop Search (optional):
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Operating System: Windows 7 64-bit

SolidWorks Media: 64-bit version for Windows XP, Windows Vista, and Windows 7

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2005 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2008 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:

rdbgexp.msiVisual Studio Remote Debugger:

.NET Framework 3.0 and Windows
Desktop Search are features of the
operating system.

.NET Framework:

Windows Desktop Search (optional):

1Installation on Windows 2003 or Windows 2008 is supported only for Workgroup PDM
Server and SolidNetWork License (SNL) Server.

Installing Windows Prerequisites from the Command Line on 32-bit Operating
Systems
Follow this process to install Windows prerequisites for administrative image installations
using the command line on 32-bit Versions of Windows.

To install multiple components in one install operation, create a batch file with the
commands provided in the following procedures and use it to push the components to
the client computers.

1. Ensure that the target computer has at least 290 MB of available disk space and a
valid TEMP directory.

2. Install Office Web Components by running this command:
administrative_image_directory \OfficeWeb_11\owc11.exe

3. For Windows XP, install Windows Installer:
administrative_image_directory
\WindowsInstaller\WindowsInstaller-KB893803-v2-x86.exe

It is not necessary to install Windows installer on any version of Windows other
than Windows XP.

4. Install the Visual C++ 2005 Redistributable Package:
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administrative_image_directory
\Microsoft_C++_2005_Redistributable\vcredist_x86.exe /Q

5. Install the Visual C++ 2008 Redistributable Package:
administrative_image_directory
\Microsoft_C++_2008_Redistributable\vcredist_x86.exe /Q

6. For Windows XP, install Microsoft .NET Framework 3.0 using Windows Server Update
Services.

It is not necessary to install the .NET Framework image on Windows Vista or
later.

7. Install the Visual Studio Tools for Applications:
administrative_image_directory \Microsoft_VSTA\vsta_aide.msi

8. For Windows XP or Windows 2003, optionally install Windows Desktop Search by
running one of these commands:

• For Windows XP: administrative_image_directory
\SolidWorks\Temp\WindowsDesktopSearch-KB917013-V301-XP-x86-lang.exe
/Q

• For Windows 2003: administrative_image_directory
\SolidWorks\Temp\WindowsDesktopSearch-KB917013-V301-Srv2K3-x86-lang.exe
/Q

Installing Windows Prerequisites from the Command Line on 64-bit Operating
Systems
Follow this process to install Windows prerequisites for administrative image installation
using the command line on 64-bit Versions of Windows.

To install multiple components in one install operation, create a batch file with the
commands provided in the following procedures and use it to push the components to
the client computers.

1. Ensure that the target computer has at least 620 MB of available disk space and a
valid TEMP directory.

2. Install Office Web Components by running this command:
administrative_image_directory \OfficeWeb_11\owc11.exe

3. Install the Visual C++ 2005 Redistributable Package:
administrative_image_directory
\Microsoft_C++_2005_Redistributable\vcredist_x64.exe /Q

administrative_image_directory
\Microsoft_C++_2005_Redistributable\vcredist_x86.exe /Q

Both the 32-bit and the 64-bit versions of this package must be installed.

4. Install the Visual C++ 2008 Redistributable Package:
administrative_image_directory
\Microsoft_C++_2008_Redistributable\vcredist_x64.exe /Q
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administrative_image_directory
\Microsoft_C++_2008_Redistributable\vcredist_x86.exe /Q

Both the 32-bit and the 64-bit versions of this package must be installed.

5. For Windows XP, install Microsoft .NET Framework 3.0 using Windows Server Update
Services.

It is not necessary to install the .NET Framework image on Windows Vista or
later.

6. Install the Visual Studio Tools for Applications:
administrative_image_directory \Microsoft_VSTA\vsta_aide.msi

7. Install the Visual Studio Remote Debugger:
administrative_image_directory \VSRemoteDebugger\install.exe /Q

8. For Windows XP or Windows 2003, optionally install Windows Desktop Search:
administrative_image_directory
\SolidWorks\Temp\WindowsDesktopSearch-KB917013-V301-XP-x86-lang.exe /Q

SolidWorks Search and Microsoft Windows Desktop Search
SolidWorks Search is integrated with Microsoft

®
Windows

®
Desktop Search.

If the correct version of Windows Desktop Search is not already installed on your computer,
you are asked to install or update it during SolidWorks installation.

If you are creating an administrative image manually on the command line, Microsoft
Windows Desktop Search must be installed manually on client computers prior to installing
from an administrative image.

Installing from the Administrative Image Using the Command Line
You can deploy installations from an administrative image using the command line.

To install silently:

1. Open a Command Prompt window (in Windows, click Start > Run.
2. Type the msiexec.exe command with the /i and /qb switches and set the properties
for any options that are not the default values as shown below.

Properties are listed for these products:

• Command-Line Feature Properties on page 30
• Command-Line Global Properties on page 31
• DWGeditor Command-Line Properties on page 33
• SolidWorks eDrawings Command Line Properties on page 34
• SolidWorks Explorer/Workgroup PDM Command-Line Properties on page 36
• SolidWorks Flow Simulation Command Line Properties on page 38

Use the following examples as templates for silent installation.
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SolidWorks Client

• Chinese-Simplified language
• PhotoWorks add-in
• Participation in the feedback program

32-bit version of SolidWorks on 32-bit operating system:

msiexec /i "Msi_path" INSTALLDIR="C:\Program Files\your_folder"
SOLIDWORKSSERIALNUMBER="xxxx xxxx xxxx xxxx xxxx xxxx" ENABLEPERFORMANCE=1
OFFICEOPTION=3
ADDLOCAL=SolidWorks,ChineseSimplified,PhotoWorksRender,Intel_Modules_AgeiaX86
/qb

32-bit version of SolidWorks on 64-bit operating system:

msiexec /i "Msi_path" INSTALLDIR="C:\Program Files\your_folder"
SOLIDWORKSSERIALNUMBER="xxxx xxxx xxxx xxxx xxxx xxxx" ENABLEPERFORMANCE=1
OFFICEOPTION=3
ADDLOCAL=SolidWorks,ChineseSimplified,PhotoWorksRender,Intel_Modules_AgeiaX64
/qb

64-bit version of SolidWorks on 64-bit operating system:

msiexec /i "Msi_path" INSTALLDIR="C:\Program Files\your_folder"
SOLIDWORKSSERIALNUMBER="xxxx xxxx xxxx xxxx xxxx xxxx" ENABLEPERFORMANCE=1
OFFICEOPTION=3 ADDLOCAL=SolidWorks,ChineseSimplified,PhotoWorksRender /qb

DWGeditor

• Standalone license

msiexec /i "Msi_path" INSTALLDIR="C:\Program Files\your_folder"
LICENSETYPE=1 /qb

eDrawings Client

• Log performance
• Italian language
• All features

msiexec /i "Msi_path" INSTALLDIR="C:\Program Files\your_folder"
LOGPERFORMANCE=1 SNLSERVER=eDrawings_SNL_server TRANSFORMS=1040.mst
ADDLOCAL=All /qb

29



SolidWorks Explorer and Workgroup PDM add-in

• SolidWorks Explorer with Workgroup PDM add-in

msiexec /i "Msi_path" INSTALLDIR="C:\Program Files\your_folder"
EXPLORERORPDM=1 ADDLOCAL=VaultAdmin,Client,Standalone,DocMgr,LicenseEXE
ACTIVSERIALNUMBER="xxxx xxxx xxxx xxxx xxxx xxxx" /qb

SolidWorks PhotoView 360

msiexec /i "Msi_path" /qb

This product is licensed through the PhotoView license.

This installation requires that a version of PhotoView 360 is already installed on your
computer. There are no command options available when installing PhotoView 360.

Command-Line Properties
Command-line properties describe here include feature properties, global properties,
product-specific properties and Windows location conventions.

Command-Line Feature Properties
This table lists the ADDLOCAL properties for command-line deployment.

SolidWorks does not support product installation using the ADDSOURCE option.

In this table:

• Properties are case sensitive, cannot contain spaces or dashes, and must be separated
by commas.

• The command must be in English regardless of the language installed.
• SolidWorks must be specified for the SolidWorks application to be installed correctly.
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PropertyProperty

ManualsLanguages:

RealViewGraphicsdisplayCzech

SolidWorksChinese

FeatureWorksChineseSimplified

InstantWebsiteEnglish

PhotoWorksRenderFrench

ScanTo3DGerman

SolidWorksAnimatorItalian

SolidWorksDesignCheckerJapanese

SolidWorksRoutedsystemsKorean

SolidWorksToolboxPolish

SolidWorksUtilitiesPortugueseBrazilian

TolAnalystRussian

CircuitWorksSpanish

DWGPartnerTurkish

Simulation

Motion

XchangeWorks

CoreSolidWorksTaskScheduler

ExampleFiles

HelpFiles

Intel_Modules_AgeiaX86

(for 32-bit SolidWorks on 32-bit operating
systems)

Intel_Modules_AgeiaX64

(for 32-bit SolidWorks on 64-bit operating
systems)

Command-Line Global Properties
Each property is defined for administrative or individual installations, unless otherwise
noted. Serial numbers can be passed to both an administrative installation and an individual
installation using global properties.
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DescriptionProperty

Whether the application should
automatically send performance data to
SolidWorks Corporation.

1 to send performance data, 0 otherwise.

ENABLEPERFORMANCE

Installation folder for SolidWorks.

Individual installations only.

INSTALLDIR

Install the SolidWorks extensions that use
Microsoft Windows Desktop Search Engine.

INSTALLWDS

For details, see Preparing Clients for
Command-Line Installation from an
Administrative Image on page 20.

1 to install the extensions, 0 otherwise.

Serial number for the SolidWorks Motion
product

MOTIONSERIALNUMBER

Specify product package to install:OFFICEOPTION

SolidWorks Client0

SolidWorks Office1

SolidWorks Professional2

SolidWorks Premium3

SolidNetWork server list.SERVERLIST

list_of_port@server_strings is a list of strings
delimited by semi-colons, each of which refers
to a port number on a server with the format:

xxxxx@server_name1;yyyyy@server_name2;&

where x and y are single digits. After the last
server in the list, do not put a semi-colon.

Individual installations only.

Serial number for the SolidWorks Simulation
product

SIMULATIONSERIALNUMBER

Serial number for the SolidWorks product,
which includes all add-ins.

SOLIDWORKSSERIALNUMBER

SolidWorks version to upgrade as it would
be shown in the list in the SolidWorks Install
Choice dialog box. For example:

SWMIGRATE="SolidWorks 2010 SP01"

SWMIGRATE
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DescriptionProperty

Installation folder for SolidWorks.

Administrative installations only.

TARGETDIR

Installation folder for SolidWorks Toolbox
files.

Individual installations only.

TOOLBOXFOLDER

Contains language-specific items of the
form:

TRANSFORMS number.mst

• Chinese (1028)
• Chinese-Simplified (2052)
• Czech (1029)
• English (1033)
• French (1036)
• German (1031)
• Italian (1040)
• Japanese (1041)
• Korean (1042)
• Polish (1045)
• Portuguese-Brazilian (1046)
• Russian (1049)
• Spanish (1034)
• Turkish (1055)

TRANSFORMS

Whether to upgrade an existing version of
SolidWorks to the current version.

New installation, do not update0

Update1

Individual installations only.

UPGRADESWINSTALL

DWGeditor Command-Line Properties
These command-line properties are specific to DWGeditor.
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DescriptionProperty

DWGASSOC
Associates .dwg files with
DWGeditor

1

Does not associate .dwg files with
DWGeditor

2

Specifies the installation folder for
DWGeditor.

INSTALLDIR

LICENSETYPE
Standalone1

Network License2

If you specify 2, you must also specify
SERVERLIST.

List of strings delimited by semi-colons,
each of which refers to a port number on a
server with the format:
xxxxx@server_name1;
yyyyy@server_name2;& where x and y are
single digits. After the last server in the list,
do not put a semi-colon.

SERVERLIST

SolidWorks eDrawings Command Line Properties
These command-line properties are specific to eDrawings.
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DescriptionProperty

Specifies which portion of the SolidWorks eDrawings
application to install.

All is the recommended option.

ADDLOCAL

Feature:Command Line Syntax:

Installs all the features. The
eDrawings application

All

searches for installed
SolidWorks and AutoCAD
publisher applications to
validate the install.

View eDrawings and other
files.

eDrawingsViewer

Create eDrawings files from
the AutoCAD R14
application.

PublisherForAutoCADR14

Create eDrawings files from
the AutoCAD 2000
application.

PublisherForAutoCAD2000

Create eDrawings files from
the AutoCAD 2004
application.

PublisherForAutoCAD2004

Create eDrawings files from
the AutoCAD 2005
application.

PublisherForAutoCAD2005

Create eDrawings files from
the AutoCAD 2006
application.

PublisherForAutoCAD2006

View DXF/DWG files in the
eDrawings Viewer.

DXFDWGTranslator

Install desktop shortcut.Shortcuts

View 3DXML files in the
eDrawings Viewer.

XML3D

Specifies the installation folder for SolidWorks eDrawings.INSTALLDIR

Specifies whether the application should automatically
email performance data to SolidWorks Corporation.

LOGPERFORMANCE

Send performance data1

Otherwise0
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DescriptionProperty

Enter the port@servername for your SolidNetWork
License server. Use semi-colons to separate multiple
port@servername combinations.

A port server name for SNLSERVER is only required for the
SolidWorks SNL server configuration.
list_of_port@server_strings is a list of strings delimited
by semi-colons, each of which refers to a port number on
a server with the format:

xxxxx@server_name1; yyyyy@server_name2;

where x and y are single digits. After the last server in the
list, do not put a semi-colon.

SNLSERVER

SolidWorks Explorer/Workgroup PDM Command-Line Properties
These command-line properties are specific to SolidWorks Explorer and SolidWorks
Workgroup PDM.

For SolidWorks Explorer/Workgroup PDM client:
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DescriptionClient Property

EXPLORERORPDM
SolidWorks Explorer only0

Workgroup PDM features can be
installed

1

ADDLOCAL • Standalone
• Client
• Client64
• VaultAdmin
• AutoCADRxxxx
• DocMgr
• DocMgr64
• LicenseEXE

Standalone is the Contributor and Client
is the SolidWorks Add-in for SolidWorks
Explorer silent installations.

If you specify AutoCAD, AutoCAD must be
installed on your system. Workgroup PDM
locates the appropriate version of AutoCAD.
You can specify more than one version of
AutoCAD:

• AutoCADR14Addin
• AutoCADR2000Addin
• AutoCADR2004Addin
• AutoCADR2005Addin
• AutoCADR2006Addin

Client64 and DocMgr64 work with only
64-bit SolidWorks Explorer installations.

Specifies the installation folder for
Workgroup PDM.

INSTALLDIR

Specifies the Solidworks serial number.ACTIVSERIALNUMBER

For Workgroup PDM Server:
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DescriptionServer Property

ADDLOCAL • Vault
• WebPortal
• API

If you specify WebPortal (the Viewer), you
must also specify VAULTNAME.

Specifies the installation folder for
Workgroup PDM.

INSTALLDIR

Specifies the name of the computer where
the license server resides.

LICENSE_SERVER

Specifies the path and folder of the vault.VAULTDATA

Specifies the name of the computer where
the vault resides.

VAULTNAME

SolidWorks Flow Simulation Command Line Properties
These command-line properties are specific to SolidWorks Flow Simulation.
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DescriptionProperty

SolidWorks Flow Simulation standalone
serial number.

(Individual installations and client
installations from an administrative image)

ACTIVSERIALNUMBER

Upgrades an existing version of a particular
SolidWorks Flow Simulation application
software.

CWUPGRADEINSTALL

Update1

New installation; install in a new
directory

2

(Individual installations and client
installations from an administrative image)

Specifies the installation for a particular
SolidWorks Flow Simulation application
software.

(Individual installations only)

INSTALLDIR

List of strings delimited by semi-colons,
each of which refers to a port number on a
server with the format:
xxxxx@server_name1;
yyyyy@server_name2;& where x and y are
single digits. After the last server in the list,
do not put a semi-colon.

SERVERLIST

Specifies the folder where the SolidWorks
software is installed.

(Individual installations and client
installations from an administrative image)

SOLIDWORKSPATH

Specifies the installation for a particular
SolidWorks Flow Simulation application
software.

(Administrative image installations only)

TARGETDIR

MSI File Locations for Administrative Images
For administrative images created from the command line, the product .msi files are
stored in these locations on the SolidWorks media.
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Media LocationProduct

swwi\data\SolidWorks.msiSolidWorks (core product)

apisdk\SolidWorks API SDK.msiSolidWorks API SDK

cwwi\SolidWorks Simulation products

COSMOSFloWorks\SolidWorks Flow
Simulation.msi

COSMOSM\COSMOSM_lang.msi

DWGeditor\DWGeditor.msiDWGeditor

eDrawings\eDrawings.msieDrawings

eDrwAPISDK\eDrawings API SDK.msieDrawingsAPI SDK

pdmwserver\SolidWorks Workgroup PDM
Server.msi

Workgroup PDM Server

PhotoView\PhotoView 360.msiPhotoView 360

swdocmgr\SolidWorks Document Manager
API.msi

DocManager APIs

swexplorer\SolidWorks Explorer.msiSolidWorks Explorer

swlicmgr\SolidWorks SolidNetWork
License Manager.msi

SolidNetWork License Manager

Windows Desktop Search Language Support
Use this table to identify the Windows Desktop Search file to install on client computers.

Simplified Chinese_chs

Chinese_cht

Czech_csy

German_deu

English_enu

Spanish_esn

French_fra

Italian_ita

Japanese_jpn

Korean_kor

Polish_plk

Brazilian Portuguese_ptb

Russian_rus
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Deploying an Administrative Image Using Microsoft Active Directory
Microsoft Active Directory Deployment is supported for deployment of the core SolidWorks
product to clients.

Microsoft Active Directory is a directory service for managing clients and servers in network
environments. It simplifies management, migration, and deployment.

1. Create an administrative image using SolidWorks Installation Manager or the command
line.

2. If you have created the administrative image using the command line, install the
Windows prerequisites for installation from an administrative image Installing Windows
Prerequisites Using Microsoft Active Directory on page 42.

Perform this step only if you created the image manually using the command
line. If you created the image using SolidWorks Installation Manager, all Windows
prerequisites were installed automatically.

3. Create a transform file to customize the SolidWorks software:
a) Open the Command Prompt window.
b) In the folder that contains the administrative image, drag SWCreateMST.exe into
the Command Prompt window.
The command should be in the format:

administrative_image_directory\SWCreateMST.exe
path_to_MSI_file_of_an_administrative_image list_of_properties

The properties can be feature properties or global properties. Use the following as
templates:

• If you are installing SolidWorks (32-bit version) on a 32-bit operating system:

C:\admin\SWCreateMST.exe "c:\admin\SolidWorks.msi"
INSTALLDIR="C:\Program Files\your_folder"
SOLIDWORKSSERIALNUMBER="xxxx xxxx xxxx xxxx"
ADDLOCAL=SolidWorks,English,Manuals,Intel_Modules_AgeiaX86
OFFICEOPTION=0 SERVERLIST="25734@your_server"

• If you are installing SolidWorks (32-bit version) on a 64-bit operating system:

C:\admin\SWCreateMST.exe "c:\admin\SolidWorks.msi"
INSTALLDIR="C:\Program Files\your_folder"
SOLIDWORKSSERIALNUMBER="xxxx xxxx xxxx xxxx"
ADDLOCAL=SolidWorks,English,Manuals,Intel_Modules_AgeiaX64
OFFICEOPTION=0 SERVERLIST="25734@your_server"

• If you are installing SolidWorks (64-bit version) on a 64-bit operating system:

C:\admin\SWCreateMST.exe "c:\admin\SolidWorks.msi"
INSTALLDIR="C:\Program Files\your_folder"
SOLIDWORKSSERIALNUMBER="xxxx xxxx xxxx xxxx"
ADDLOCAL=SolidWorks,English,Manuals OFFICEOPTION=0
SERVERLIST="25734@your_server"

The transform file, SolidWorks.mst, is created in the folder that contains the
administrative image.
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4. In the Active Directory, edit the Published Apps policy for the group or groups to
deploy the SolidWorks software.

5. In the Group Policy dialog box, expand Computer Configuration and Software Settings.
6. Right-click Software installation and select New > Package.
7. Browse to the administrative image and click Open.
8. In the Deploy Software dialog box, select Advanced published or assigned, then

click OK.
9. In the SolidWorks Properties dialog box, on the Modifications tab:

a) Click Add.
b) Browse to the .mst file.
c) Click Open.

10. Click OK.

Installing Windows Prerequisites Using Microsoft Active Directory
Follow this process to prepare an existing administrative image that will install SolidWorks
onto client computers using Microsoft Windows Active Directory.

In these processes, use the command that is appropriate to the version of SolidWorks
you are deploying.

1. Extract the 2005 Visual C++ Redistributable Package installer files and install them.
a) Run one of these commands.

For 32-bit versions of Windows:

administrative_image_directory\Microsoft_C++_2005_Redistributable\vcredist_x86.exe
/C /T:{C++_target_directory}

For 64-bit versions of Windows:

administrative_image_directory\Microsoft_C++_2008_Redistributable(64)\vcredist_x64.exe
/C /T:{C++_target_directory}

b) Create a policy to install the Microsoft C++ 2005 redistributable module:
{2005_C++_target_directory}\vcredist.msi –

No transform file is needed for this installation.

2. Extract the 2008 Visual C++ Redistributable Package installer files and install them.
a) Run one of these commands.

For 32-bit versions of Windows:

administrative_image_directory\Microsoft_C++_2008_Redistributable\vcredist_x86.exe
/x:{C++_target_directory}

For 64-bit versions of Windows:

administrative_image_directory\Microsoft_C++_2008_Redistributable(64)\vcredist_x64.exe
/x:{C++_target_directory}

b) Create a policy to install the Microsoft C++ 2008 redistributable module:
{2008_C++_target_directory}\vcredist.msi –

42



No transform file is needed for this installation.

3. Using Windows Server Update Services, install Microsoft .NET Framework 3.0.

It is not necessary to install the .NET Framework image on Windows Vista or
later.

4. Extract the Office Web Components files and install them.
a) Run this command:

administrative_image_directory\OfficeWeb_11\owc11.exe
/extract:{Office_Web_components_directory}

b) Create a policy to install the Office Web Components:
{Office_Web_components_directory}\owc11.MSI

No transform file is needed for this installation.

5. Install the Visual Studio Tools for Applications (VSTA), by creating this policy:
{Microsoft_VSTA_directory}\vsta_aide.MSI

No transform file is needed for this installation.

6. Install the Visual Studio Remote Debugger (64-bit versions only), by creating this
policy:
{Microsoft_remote_debugger_directory}\rdbgexp.MSI

No transform file is needed for this installation.

Administration of Multiple Installations
For multiple installations, administrative tasks include upgrading administrative images
to new releases, applying service pack updates, and removing installations.

Upgrading Administrative Images to a New Release
To update clients who installed from an administrative image, first update the
administrative image and then configure the clients to reference the new copy of the
image.

Run the Installation Manager from the Internet so that the correct files are referenced.
The Installation Manager will redirect itself to do this, or you can run the update directly
from the SolidWorks Downloads Web site
(http://www.solidworks.com/sw/support/downloads.htm).

Once you have updated the administrative image (which creates a new copy of the image),
you can update clients by having them reference the new copy of the administrative
image.

If clients referenced the previous version of the administrative image using a mapped
drive or a shared directory, you could redefine that mapped drive or shared directory
using the location of the updated copy of the administrative image.
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Downloading Updated Installation Files for Administrative Images
SolidWorks Installation Manager can detect when you need updated installation files when
upgrading an administrative image.

1. Start the SolidWorks Installation Manager by inserting the DVD.
2. On the Welcome screen, select:

• Administrative image and server products
• Create or update an Administrative Image.

3. On the Serial Number screen, enter the SolidWorks serial number.
The Installation Manager checks the SolidWorks Web site for your licensed products
and available service packs.

4. If the Newer Version Available screen appears, select Yes, I would like to get the
latest version: version.
Installation Manager starts a new Installation Manager session.

5. If there is a problem with the download folder, Download Options might appear, in
which case, accept the default directory for the new installation files or enter a new
directory name.

If you see a message that the directory does not exist, click Yes to create it.

6. On the Download Complete screen, click Close to close the current installer and start
the installer for the new version.

Upgrading an Administrative Image
To upgrade an administrative image, SolidWorks Installation Manager creates a new
image directory. You then direct clients to use the new administrative image directory to
upgrade to that product version.

This process assumes you have downloaded any updated installation files for the
administrative image.

1. Start SolidWorks Installation Manager (as described under Initiating SolidWorks
Installation on page 6).

2. In the Welcome screen, select the following:

• Administrative image and server products
• Create or update an Administrative Image.

3. On the Serial Number screen, check the serial number.
4. On the Summary (Ready to Create Image) screen, check that the administrative

image options are correct.
For details about individual administrative image and installation options, click
CHANGE to go to the option page and then click Help.

5. To create the new version of the administrative image, click Create Now.

You can now upgrade clients to this new version of the administrative image.

Upgrading Clients from Administrative Images
The Installation Manager can automatically update client computers installed from an
administrative image.
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Typically, administrative images are organized in folders on a server. To support the
automatic upgrade of clients, the SolidWorks administrative image must be located in a
shared folder.

After upgrading the administrative image, the original installation will be in one folder
and the upgraded installation will be in another folder. To use the upgraded installation,
remove the sharing option from the original administrative image folder and then add
the sharing option to the upgraded administrative image folder.

When SolidWorks starts on a client machine that installed from the original administrative
image, it sees the new version and upgrades the client.
Removing the Sharing Option from the Original Administrative Image Folder
When upgrading an administrative image that is accessed from a shared folder, you must
remove the sharing option from the original folder.

1. Browse to the folder where the original administrative image files are located.
2. Right-click the folder and select Properties.
3. On the Sharing tab, select Do not share this folder, and then click OK.

Now add the sharing option to the upgraded administrative image folder as described in
Adding the Sharing Option to an Upgraded Administrative Image Folder on page 45.
Adding the Sharing Option to an Upgraded Administrative Image Folder
Once you have created an updated administrative image folder and disabled the sharing
for the original administrative image folder, you must add the sharing option to the new
folder to re-enable the administrative image.

1. Browse to the folder where the upgraded administrative image files are located.
2. Right-click the folder and select Properties.
3. On the Sharing tab, select Share this folder and then click New Share.

In the New Share dialog box, change the share name to the share name used for the
original administrative image folder and then click OK.

Computers that installed from the original administrative image share location will upgrade
to the new version automatically when starting SolidWorks.
Upgrading Clients of Administrative Images Manually Using the Command Line
Once you have upgraded an administrative image, you can upgrade clients manually
using the command line.

1. Make sure all clients are at the same service pack of the previous release. (Clients
that do not already have the application installed are not upgraded.)

2. Optionally, on one of the client systems, run the Copy Settings Wizard to capture the
current SolidWorks options.

3. Create a new administrative image using one of these methods:

• SolidWorks Installation Manager
• Command Line

Do not upgrade or overwrite the previous image.

4. Upgrade all clients to the new version using the msiexec command, with these
specifications:

• Include the /I and qb msiexec command-line options.
• Specify any required feature and global command-line properties.
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For example, to upgrade an existing version of SolidWorks:

msiexec /I Msi_path" INSTALLDIR="C:\Program Files\your_folder"
SOLIDWORKSSERIALNUMBER="xxxx xxxx xxxx xxxx xxxx xxxx" UPGRADESWINSTALL=1
SWMIGRATE="SolidWorks version servicepack" /qb

Service Pack Product Update Administration
Service Pack product updates can contain updates for system reliability, program
compatibility, security, and so on.

You can acquire product updates in two ways:

By using the Installation Manager to check for, download, and
install updates.

You can initiate the Installation Manager manually, or schedule
it to check periodically for updates.

For current
versions of
SolidWorks:

By downloading service packs manually from the SolidWorks
support Web site.

Service packs are applied as patches to an existing software
version. For example, SolidWorks 2007 SP1.0 is a service pack

For versions of
SolidWorks prior to
2008:

for SolidWorks 2007 SP0.0. You can install these service packs
using the SolidWorks 2007 Installation Manager; you cannot install
them using the Installation Manager in SolidWorks 2008 or later.

For instructions on downloading and installing service packs, see
the installation documentation for the SolidWorks version you are
updating.

Rolling Back Service Packs in an Administrative Image
You can roll back an administrative image to an earlier installed service pack. If you
installed the SolidWorks software with disks, you need the original disks to restore a
service pack. You must have saved a copy of the earlier administrative image.

Administrative images that have been upgraded cannot be rolled back to a previous
service pack. Administrative images created with any method other than the
SolidWorks Installation Manager cannot be rolled back to a previous version. Clients
installed from these administrative images must be uninstalled and then reinstalled
using an administrative image created from the previous version.

1. Delete the folder that contains the current administrative image. To do this, open the
Command Prompt window and enter:
rmdir /s/q path_to_current_administrative_image

2. Move the backup copy of the administrative image to the location where you deleted
the current administrative image. To do this, open the Command Prompt window and
enter:
move path_to_backup_administrative_image
path_to_current_administrative_image

After you roll back an administrative image, client computers roll back automatically
the next time they run the SolidWorks software.
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Applying Service Packs to Clients Deployed with Microsoft Active Directory
If you have installed the SolidWorks software using the Microsoft Active Directory, you
can apply service packs to clients with it.

1. Copy the administrative image to a new folder using the following command line:
xcopy path_to_current_administrative_image
path_to_backup_administrative_image /s/i/v

2. Apply the service pack to the copy of the administrative image.
3. Create a new transform file to specify an upgrade installation for the SolidWorks

software:
a) Open the Command Prompt window.
b) In the folder that contains the administrative image, drag SWCreateMST.exe into
the Command Prompt window.
The command format is:

path_to_administrative_image\SWCreateMST.exe
path_to_MSI_file_of_an_administrative_image list_of_properties

The command line must include all of the parameters used to create the
original transform file, plus the global properties UPGRADESWINSTALL and
SWMIGRATE.

For example, if the original command was:

C:\admin\SWCreateMST.exe "c:\admin\SolidWorks.msi"
INSTALLDIR="C:\Program Files\your_folder" SOLIDWORKSSERIALNUMBER="xxxx
xxxx xxxx xxxx"
ADDLOCAL=SolidWorks,English,Manuals,Intel_Modules_AgeiaX86
OFFICEOPTION=0 SERVERLIST=25734@your_server

the update command must be:

C:\admin\SWCreateMST.exe "c:\admin\SolidWorks.msi"
INSTALLDIR="C:\Program Files\your_folder" SOLIDWORKSSERIALNUMBER="xxxx
xxxx xxxx xxxx"
ADDLOCAL=SolidWorks,English,Manuals,Intel_Modules_AgeiaX86
OFFICEOPTION=0 SERVERLIST=25734@your_server UPGRADESWINSTALL=1
SWMIGRATE="SolidWorks version service_pack"

The transform file, SolidWorks.mst, is created in the folder that contains the
administrative image.

The original and update commands in this example are for installing the 32-bit
version of SolidWorks on a 32-bit version operating system. If you are
installing the 32-bit version of SolidWorks on a 64-bit operating system, you
would use "Intel_Modules_AgeiaX64" in place of "Intel_Modules_AgeiaX86".
If you are installing the 64-bit version of SolidWorks on a 64-bit operating
system, you would not use either "Intel_Modules_AgeiaX86” or
“Intel_Modules_AgeiaX64".

4. In the Active Directory, edit the Published Apps policy for the group or groups to
deploy the SolidWorks software.

47



5. In the Group Policy dialog box, expand Computer Configuration and Software
Settings.

6. Right-click Software installation and select New > Package.
7. Browse to the administrative image and click Open.
8. In the Deploy Software dialog box, select Advanced published or assigned, then

click OK.
9. In the SolidWorks Properties dialog box, on the Modifications tab:

a) Click Add.
b) Browse to the .mst file.
c) Click Open.

10. Click OK.

Removing an Installation
You can remove an installation on an individual computer or in a client/server environment.

1. Make sure no SolidWorks sessions are active.
2. If you wish to transfer the SolidWorks license to another computer, transfer the license

to that computer before removing the SolidWorks installation on this computer.

For information about transferring SolidWorks licenses, see Transferring a License
on page 56.

3. In Windows, open the Control Panel and double-click Add or Remove Programs.
4. In Add or Remove Programs, select the product component to remove.

In some cases, you might find multiple SolidWorks Service Pack components
for a given major release version. To remove a SolidWorks major release, remove
all Service Pack elements for that major release in Add or Remove Programs.

5. Click Remove.
6. In the SolidWorks Installation Manager, on the Products to Remove screen:

a) Select the products to remove.

By default, all product components are selected.

b) Clear the products you do not want to remove.
c) Click Remove Items.

48



Workgroup PDM
The Workgroup PDM application is product data management software that runs inside
the SolidWorks environment or as a standalone application inside SolidWorks Explorer.
Workgroup PDM controls projects with procedures for check out, check in, revision control,
and other administration tasks.

A Workgroup PDM system is illustrated as follows:

• A computer can contain only one Vault.
• The Vault directory cannot be a hidden or read-only directory.
• As a client/server application, Workgroup PDM performance depends on a robust
network.

• If your users maintain a large number of documents, performance is improved if
you create more projects or subprojects with fewer documents per project instead
of keeping the documents in a smaller number of projects with more documents
per project.

Installation
• Clients and the VaultAdmin, API, and Viewer can be installed on the same computer
as the Vault, or on different computers.

• It is not necessary to install the Workgroup PDM Server to install the client API. The
client API is installed during the Workgroup PDM Client installation.

• To configure the vault folder on a remote location, type the full Universal Naming
Convention (UNC) path when prompted for the server destination.

• Installing or updating the vault requires a computer reboot.
• If the Workgroup PDM Server Service does not start automatically after rebooting, you
must start it manually. In Windows Explorer, run pdmwvault.exe in the
install_dir\SolidWorks Workgroup PDM\Vault folder.

• When you install a Workgroup PDM client, you must install solidworksexplorer.exe
on each computer. This executable can be on a shared drive. The Workgroup PDM
Vault, Viewer, API Client, and VaultAdmin are not installed on each client computer.
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Licenses
• A license for Workgroup PDM API is included with the licenses of SolidWorks clients
and Explorer clients. Check-in APIs require client licenses.

• A Workgroup PDM Viewer license must be installed with the vault to enable the Viewer.

Permissions
• The vault administrator should have write permission for installation and for the vault
folder.

• The vault administrator should manage the vault folder from the VaultAdmin, not with
Windows Explorer.

• Users should never have write permission in Windows Explorer for the vault folder.

Security, Ports, and Duplex Settings
• Workgroup PDM must be able to install as a Windows service, so other applications
cannot be allowed to block or filter the service. For example, if anti-spyware tools such
as Microsoft AntiSpyware display an alert requiring approval during the installation
process, click Allow so the Workgroup PDM Server is installed as a Windows Service.

• If you install Workgroup PDM on a Windows XP system with Service Pack 2, a Windows
2003 server with Service Pack 1, or a computer with an active firewall, you must enable
Workgroup PDM ports as exceptions in the firewall setup.

Typically, the ports are:

• 20000 (VaultAdmin)
• 30000 (Data)
• 40000 (Request)
• 80 (Viewer)

For information on changing the port settings, see Troubleshooting for Vault
Administrators in the Workgroup PDM and SolidWorks Explorer help and the Microsoft
Windows help for Security Center. To install the Workgroup PDM Vault and the Viewer
concurrently, use the Custom option in the Setup Type dialog box.

• The duplex setting for servers and their corresponding ports should be the same; for
example, both could be 100MB Full or both could be Auto.

SolidWorks Toolbox Documents
SolidWorks Toolbox documents are common hardware components that usually do not
require revision control and are not checked in to the Workgroup PDM Vault. See the
Workgroup PDM online help for details about configuring SolidWorks Toolbox and other
standard libraries.

Workgroup PDM Viewer
The Workgroup PDM software automatically sets up a virtual directory during installation
using Microsoft Internet Information Services (IIS).

You must install Microsoft Internet Information Services (IIS) before installing the
Viewer. See Microsoft documentation for installation instructions.

The Workgroup PDM Viewer installation is subject to these restrictions:

• The Web Site Content Directory is the Viewer installation folder.
• You cannot use underscore characters in the name of the machine that hosts the Viewer.
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• If you install the Viewer on Windows XP Service Pack 2, you must enable a port in the
Windows Firewall for HTTP (port 80).

• The Viewer can point to only a single vault at any time.

Users access the Workgroup PDM Viewer by typing this URL into the address field of
Internet Explorer:

http://ViewerComputerName/pdmweb/

Installing a Workgroup PDM Server
Installing the Workgroup PDM Server creates a Workgroup PDM vault, which is the
database that stores the managed SolidWorks projects.

1. Start SolidWorks Installation Manager (as described under Initiating SolidWorks
Installation on page 6).

2. In the Welcome screen, select the following:

• Administrative Image and Server products
• Install SolidWorks Workgroup PDM Server (vault) on this computer

3. On the Serial Number screen, click SolidWorks Workgroup PDM, and enter the
SolidWorks Workgroup PDM serial number.

4. Follow the SolidWorks Workgroup PDM Server installation instructions, selecting Vault
as the Setup Type.

5. On the final screen, do one of the following:

• If you have already installed SolidWorks Explorer, clear Launch SolidWorks
Explorer Install and then click Finish.

• If you have not installed SolidWorks Explorer, ensure that Launch SolidWorks
Explorer Install is checked and then click Finish.

Configuring Workgroup PDM for Clients
After you have installed the Workgroup PDM server vault, you can then configure the
vault for clients.

1. Log in to the VaultAdmin (installed with SolidWorks Explorer) with the default user
name and password.

2. In the VaultAdmin, set up user and group accounts, project folders, permissions, and
so on.

For instructions, see Workgroup PDM Help.

3. Email client users with the server computer name and their user names and passwords,
which are usually not the same as their Microsoft Windows user names and passwords.

Configuring the Workgroup PDM Viewer to Connect to a Different
Vault Location
You can configure Workgroup PDM Viewer to connect to a different Vault location using
the Windows Registry.

1. Update the registry path by changing the Vault Computer value:
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HKEY_LOCAL_MACHINE\SOFTWARE\SolidWorks\SolidWorks2009\PDMWorks
Workgroup\Vault Computer

2. Reinstall the Workgroup PDM Viewer. In the Vault Computer Name dialog box, type
the new computer name.

Configuring Mime Types for Document Downloading
You can configure mime types for document downloading using Windows Registry settings.

By default, the Viewer sends Open Document requests with the generic mime type
"application/octet-stream." Microsoft Internet Explorer then opens the requested document
with the supplied file extension. You can map additional mime types or turn off mime
type mappings by modifying the Mime Types registry sub-key in Windows Registry.

To map additional mime types, create additional string values under this registry
sub-key:
HKEY_LOCAL_MACHINE\SOFTWARE\SolidWorks\SolidWorks2009\PDMWorks
Workgroup\WebPortal\Mime Types

in the form:

"ext" = "mime type"

For example:

"dxf" = "image/vnd.dxf"

You must manually create this registry sub-key before you add the values.

To turn off mime type mappings, change the Use Custom MIME Types registry
value to 0 (zero).

HKEY_LOCAL_MACHINE\SOFTWARE\SolidWorks\SolidWorks2009\PDMWorks
Workgroup\WebPortal\Use Custom MIME Types

Restarting the web server is not required to activate this setting.

Workgroup PDM Client Access
Workgroup PDM clients use Microsoft Windows login access control, have Web access
through the Workgroup PDM Viewer, and are updated automatically whenever the
Workgroup PDM Vault has been updated.

Client user names and passwords are not
the same in Workgroup PDM as for Microsoft
Windows login. Contact your system
administrator for login information.

To log in as a Workgroup PDM client:

Contact your system administrator for the
URL to connect to the Viewer.

To connect to the Workgroup PDM Viewer:

The Workgroup PDM clients (SolidWorks
add-in and Contributor) detect when the
Vault has been updated. You do not need
to download a service pack to update
clients.

To update the Workgroup PDM clients:
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Workgroup PDM VaultAdmin Administration
After Workgroup PDM is installed, vault administrators should perform these tasks.

• Log in to the VaultAdmin.
• Change the vault administrator password.
• Create user accounts.
• Notify users of their account names and passwords.

For details, see SolidWorks Workgroup PDM in the main SolidWorks help.

Initial Login to Workgroup PDM VaultAdmin
When you first login to Workgroup PDM VaultAdmin, specify the Workgroup PDM
administrator name and password, and the name of the computer hosting the Workgroup
PDM Vault.

1. In Windows, click Start > All Programs > SolidWorks version > Workgroup
PDM VaultAdmin.

2. In the dialog box, enter this information:

pdmwadminName

pdmwadminPassword

The host name of the computer where the vault is installed. If you
run the VaultAdmin on the computer where the vault is installed,
type localhost.

Vault
computer

3. Click Login.

For security reasons, we recommend that you change the password for the administrator
as soon as possible. Select the Users and Groups tab in the VaultAdmin.

Upgrading the Workgroup PDM Vault Server
You can upgrade the Workgroup PDM Vault Server using the SolidWorks Installation
Manager Check for Updates functionality, a SolidWorks installation DVD, or a Workgroup
PDM upgrade file manually downloaded to a local folder.

You can install only one version of Workgroup PDM Vault Server

1. Ask all users to log out of the Workgroup PDM vault and then lock it.
2. Backup the vault data.
3. Use Microsoft Windows Control Panel Add/Remove Programs to remove the current

version of Workgroup PDM Server.
4. Install the new version of Workgroup PDM Server.

• To use SolidWorks Installation Manager Check for Updates:

1. In Windows, click Start > All Programs > SolidWorks Installation Manager
> Check for Updates.

2. In the Newer Versions Available dialog box, select Download and install a
new version, select the version to install, and then click Next.

The new version of the Installation Manager downloads and runs.
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• To use a SolidWorks installation DVD, insert the DVD into the drive and follow the
Installation Manager instructions.

• To use the manually downloaded Workgroup PDM installation file (pdmwserver.exe),
double-click the file and then follow the instructions to upgrade the Workgroup
PDM Server.

5. Use SolidWorks Task Scheduler to update the Workgroup PDM files in the vault.
6. Unlock the vault and then notify users that they can return to using it.

Upgrading Workgroup PDM Clients
Clients are prompted to update the first time they log in after the vault is updated. No
service pack is required for client updates.

ActionClient Status Relative to Vault

NoneSame version as vault

NoneSame major release, newer than vault

Login is blockedNewer major release, newer than vault

Optional updateSame major release, older than vault

Mandatory updateOlder major release, older than vault

For details about updating Workgroup PDM clients, see Update Clients in the Workgroup
PDM Help.
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License Administration
After installation, you can activate SolidWorks licenses either by activating individual
computers (license activation) or by installing and activating floating network licenses on
a server (SolidNetWork Licensing).

Typically, installations on individual computers use license activation; however, you can
install the software individually and then control the licenses with SolidNetWork License
Manager. Conversely, although larger sites typically use floating network licenses, you
can deploy the installations from an administrative image and then activate the serial
numbers from the individual computers.

Administering Individual Licenses
Typically, administration of individual licenses consists of activating and transferring
licenses directly from SolidWorks.

Activation is a product licensing and registration process for SolidWorks standalone
(non-SolidNetWork License) licenses. Typically, if your product license has not yet been
activated, SolidWorks tries to activate it when you start the product.

You can also transfer individual licenses, by clicking Help > Transfer Licenses in
SolidWorks.

Activating a License
Before you can run SolidWorks products on an individual computer, you must activate
the license for that computer.

Activation requires that you have Internet or email access. After activation, you do not
need to be online to use the products. If you do not have email access on the computer
where you use this product, you can save the activation file and send it from another
computer.

This process:

• Activates all software licenses across the SolidWorks product line.
• Allows you to transfer licensing rights from one computer to another.
• Enables you to install and activate the SolidWorks products on one work computer and
one home computer.

• Can be performed immediately (recommended) or within 30 days of installation.
• Eliminates the need for dongles. However, if you run previous versions of SolidWorks
products that do not use activation, you need to retain the dongle.

For system administrators who have multiple serial numbers to manage, you can use the
Administrative Image Option Editor.

To activate a license:

1. Start the SolidWorks application.
2. Start SolidWorks Product Activation using one of these methods:

• If you have not yet activated the license for this computer, the SolidWorks Product
Activation window appears automatically when you start SolidWorks.
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• If the SolidWorks Product Activation window does not appear automatically, start
activation by clicking Help > Activate Licenses.

3. Click the Product listing to specify the product whose license you want to activate.
4. Specify automatic activation over the internet or manual activation using email.
5. Supply email contact information.
6. Click Next to proceed.

• Internet: Activation occurs automatically.
• Email: Press Save to create a request file, then email the file to
activation@solidworks.com. When you receive the email containing the response
file, extract the file from email and then click Open to load it.

If necessary, you can exit and rerun the activation procedure to open the
response file.

7. Click Finish.

Transferring a License
To transfer a license to a new or upgraded computer, first transfer it to the license key
server at Dassault Systèmes SolidWorks Corporation, then reactivate it on the other
computer.

If you were unable to transfer the license to Dassault Systèmes SolidWorks
Corporation (because of hard drive failure, for example), reactivation is still successful
in most cases. If not, contact your VAR for help.

To transfer a license back to the server:

1. In SolidWorks, click Help > Transfer Licenses, and follow the instructions.
2. To reactivate, go to the new or upgraded computer and activate the license like the

initial activation.

Administering Licenses Using a SolidNetWork License Manager
SolidNetWork License Manager supports multiple license clients by distributing licenses
to clients on the network. This allows the number of users to exceed the number of
licenses by using floating licenses.

This image depicts a typical SolidNetWork licensing installation:
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This image illustrates:

• SolidNetWork License Manager software is installed and activated on the license manager
computer only.

• License client computers do not have any additional SolidNetWork-specific software
installed.

If you specify a SolidNetWork License serial number when installing, SolidWorks
Installation Manager identifies that computer as a SolidNetWork license client.
Installation Manager prompts you for the SolidNetWork license manager computer
name and port number to connect the client to the license manager.

• The license manager and all license clients must have TCP/IP (Transmission Control
Protocol/Internet Protocol) connectivity.

Activating a SolidNetWork License
Before users can run SolidWorks products on their individual computers, you must activate
a SolidNetWork license on the SolidNetWork License Manager computer.

Activation requires that you have Internet or email access. After activation, you do not
need to be online to use the products. If you do not have email access on the computer
where you use this product, you can save the activation file and send it from another
computer.

This process:

• Activates the SolidWorks SolidNetWork License Manager with SolidNetWork licenses
across SolidWorks products.

• Allows you to transfer SolidNetWork licensing rights from one SolidNetWork License
Manager computer to another.
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• Enables you to install and activate the SolidNetWork licensing rights on one SolidNetWork
License Manager computer.

• Must be performed before you can use SolidNetWork licenses.
• Eliminates the need for dongles. If you activate a SolidNetWork license for this version
of SolidWorks, SolidNetWork licenses for previous versions of SolidWorks are activated.
(You no longer need to retain the dongle.)

To activate a SolidNetWork license:

1. Start the SolidNetWork License Manager (Start > Programs > SolidWorks version
> SolidNetWork License Manager > SolidNetWork License Manager).

2. If you have not yet activated the SolidNetWork license, you are asked whether you
want to activate it now. Click Yes to activate.

3. Under How would you like to activate?, select Automatically over the internet
(recommended).

4. Under Contact Information, specify an email contact address.

The Activation/Reactivation Succeeded dialog box displays the products that have been
activated.

Transferring a SolidNetWork License
To transfer a SolidNetWork license to a new or upgraded computer, first transfer the
license to the license key server at Dassault Systèmes SolidWorks Corporation, then
reactivate it on the other computer.

If you were unable to transfer the license to Dassault Systèmes SolidWorks
Corporation (because of hard drive failure, for example), reactivation is still successful
in most cases. If not, contact your VAR for help.

To transfer a SolidNetWork license back to the server:

1. Start the SolidNetWork License Manager (Start > Programs > SolidWorks version
> SolidNetWork License Manager > SolidNetWork License Manager).

2. Under License Information, clickModify. The SolidWorks Product Activation wizard
starts.

3. UnderWhat would you like to do?, select Transfer a software license and then
click Next.

4. Under How would you like to transfer?, select Automatically over the internet
(recommended).

5. Under Contact Information, specify an email contact address.
6. Click Next. The product license transfer completes.

Installing and Configuring SolidNetWork Licensing
Configuring SolidNetWork Licensing consists of installing the SolidNetWork License Manager
on the license manager computer and then installing SolidWorks on client computers
using the SolidNetWork license serial number.

Installing and Activating a License Manager
The SolidNetWork License Manager supports multiple license clients. It distributes licenses
to clients on the network.
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1. Start SolidWorks Installation Manager (as described under Initiating SolidWorks
Installation on page 6).
a) For type of installation, select the following:

• Administrative Image and Server products
• Install SolidNetWork License Manager (distributed licensing) on this
computer

b) For serial number, provide the SolidNetWork License serial number.
c) Follow the online instructions to complete the installation in SolidWorks Installation
Manager.

2. To activate SolidNetWork licensing, start the SolidNetWork License Manager.
a) When prompted to activate, click Yes.
b) On the SolidNetWork License Server Information screen:

• If your company uses a firewall, select A firewall is in use on this server.

For more information, see Using SolidNetWork Licenses with Firewalls on page
63.

• Use the default value for Port Number (and for Vendor Daemon Port Number
if you have a firewall) or specify the port numbers your company uses.

The port number is a TCP/IP port number in the 1024-60000 range, used
exclusively by this process. Normally, the default (25734) is suitable and
is unlikely to be the same as any other FLEXnet server process currently
on the license manager computer.

c) On the Activate Your SolidWorks Product screen:

• Select the Internet or email procedure.
• Supply email contact information.
• Click Next to proceed.

• Internet: Activation occurs automatically.
• Email: Press Save to create a request file, then send the file to
activation@solidworks.com. When you receive the email containing the
response file, extract the file from email and then click Open to load it.

If necessary, you can exit and rerun the activation procedure to open
the response file.

3. Click Finish.

Installing a License Client
When installing SolidWorks on SolidNetWork License Client computers, the serial number
identifies that computer as a SolidNetWork License Client.

1. Start SolidWorks Installation Manager (as described under Initiating SolidWorks
Installation on page 6).

2. On the Welcome screen click Individual (on this computer) if this is the first
SolidWorks installation on this computer for this major release.
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If you are upgrading from an existing release, and are changing from individual
licensing to SolidNetWork licensing, click Modify the individual installation
(on this computer). For details, see Upgrading from Individual Licensing to
SolidNetWork Licensing on page 68.

3. When prompted for a serial number, enter the SolidNetWork License serial number.
4. In the Add Server dialog box, type the SolidNetWork License Manager's address in

the form:

port@ComputerName

The port number must be the same one used for the license manager computer. The
default is 25734 (as described in Installing and Activating a License Manager on page
58).

Installation Manager will attempt to validate that this SolidNetWork License
Manager is accessible. If you have not yet installed a license manager, this
validation will fail; however, you still can proceed with the license client
installation.

5. Complete the SolidWorks installation by following the Installation Manager instructions.

Install SolidNetWork License Managers Before Installing License Clients
You should install and configure SolidNetWork License Manager on at least one computer
prior to installing any SolidNetWork license client computers.

When installing with a SolidNetWork License serial number, SolidWorks Installation
Manager prompts you to enter the SolidNetWork License Manager computer name and
port number, and then attempts to validate that information.

If you have not yet installed SolidNetWork License Manager on the computer you specified,
this validation cannot succeed. However, in this case validation failure does not indicate
whether you have supplied correct license manager information. If the license manager
is installed, validation failures indicate that you have specified incorrect license manager
information.

Triad License Manager Installation
Triad license managers use three computers for extra stability. If the computer managing
the license file is not available, one of the other two computers takes over.

Requirements for using triad license managers:

• Three hardware dongles are required.
• Install triad license managers only on stable computers not scheduled for frequent
shutdowns.

• The three license manager computers should be on the same subnet. Never configure
triad license managers with slow communications or dial-up links.

• The system administrator should detect when a license manager computer goes down
and should restart it as soon as possible.

If only two license manager computers are running, the situation is worse than
a single license manager computer, because there are two points of failure.
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Installing the Initial Triad License Manager
Triad license managers use three computers for extra stability. This process shows how
to install SolidNetWork License Manager on the first computer in the triad.

1. On the first triad license manager computer, install the SolidNetWork License Manager
using SolidWorks Installation Manager:
a) Start SolidWorks Installation Manager (as described under Initiating SolidWorks
Installation on page 6).

b) For type of installation, select the following:

• Administrative Image and Server products
• Install SolidNetWork License Manager (distributed licensing) on this
computer

c) For serial number, provide the SolidNetWork License serial number.
d) Follow the SolidWorks SolidNetWork License Manager Setup instructions to complete
the installation.

The serial number in the license manager installation wizard is pre-set to the
SolidWorks SolidNetWork serial number you provided when you started the
Installation Manager.

2. Using the SolidNetWork License Manager, configure the initial triad license manager
computer:
a) Start the SolidNetWork License Manager (Start > Programs > SolidWorks

version> SolidNetWork LicenseManager> SolidNetWork LicenseManager).
Since this is the first time you are running the SolidNetWork License Manager on
this computer, you are asked whether you would like to activate now.

b) Click No.
The Server Administration tab of the SolidWorks SolidNetwork License Manager
appears.

c) Under Advanced Options, click Options.
The Advanced Options dialog box appears.

d) Under SolidNetWork Server License Mode, click Use a License File and click OK.
The Advanced Options dialog box closes.

e) Under License Information, click Modify.
The SolidNetWork License File Wizard appears.

f) Under Server Type, select Triad and click Next.
g) On the Server Information pane, verify that the computer name, dongle ID, and
port number for the initial triad license manager computer are correct, and click
Next.

If your computer uses a firewall, you might have to make some additional
specifications on this screen. For more information, see Using SolidNetWork
Licenses with Firewalls on page 63.

h) On the Triad Partner Server Information screen, enter the computer name and
dongle ID values for the other two triad license manager computers.

This ensures that if one license manager is unavailable, client computers can
get a license from the other two servers.
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i) On the Licenses screen, click Read to browse to and open the SolidNetWork license
file.
The licenses appear in the SolidNetWork License File wizard.

j) Click Finish.
k) Click OK to exit the SolidNetWork License File wizard and then Finish to exit the
SolidNetWork License Manager.

Installing the Triad License Manager on Subsequent Computers
Triad license managers use three computers for extra stability. This process shows how
to install SolidNetWork License Manager on the second and third computers in the triad.

It is assumed that you already have installed at least one triad license manager on another
computer.

1. On the triad license manager computer, install the SolidNetWork License Manager
using SolidWorks Installation Manager:
a) Start SolidWorks Installation Manager (as described under Initiating SolidWorks
Installation on page 6).

b) For type of installation, select the following:

• Administrative Image and Server products
• Install SolidNetWork License Manager (distributed licensing) on this
computer

c) For serial number, provide the SolidNetWork License serial number.
d) Follow the SolidWorks SolidNetWork License Manager Setup instructions to complete
the installation.

The serial number in the license manager installation wizard is pre-set to the
SolidWorks SolidNetWork serial number you provided when you started the
Installation Manager.

2. Using the SolidNetWork License Manager, configure the triad license manager
computer:
a) Start the SolidNetWork License Manager (Start > Programs > SolidWorks

version> SolidNetWork LicenseManager> SolidNetWork LicenseManager).
Since this is the first time you are running the SolidNetWork License Manager on
this computer, you are asked whether you would like to activate now.

b) Click No.
The Server Administration tab of the SolidWorks SolidNetwork License Manager
appears.

c) Under Advanced Options, click Options.
The Advanced Options dialog box appears.

d) Under SolidNetWork Server License Mode, click Use a License File and click OK.
The Advanced Options dialog box closes.

e) Under License Information, click Modify.
The SolidNetWork License File Wizard appears.

f) Under Server Type, select Triad and Synchronize server/license information
and then click Next.

g) On the Server Information pane, verify that the computer name, dongle ID, and
port number for this triad license manager computer are correct, and click Next.
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If your computer uses a firewall, you might have to make some additional
specifications on this screen. For more information, see Using SolidNetWork
Licenses with Firewalls on page 63.

h) On the Triad Partner Server Information screen, enter the computer name and
dongle ID values for the other two triad license manager computers.

This ensures that if one license manager is unavailable, client computers can
get a license from the other two servers.

i) On the Licenses screen, click Read to browse to and open the SolidNetWork license
file.

Typically, the licenses file is located on \licenses\sw_d.lic on the first triad
license manager computer you configured.

The licenses appear in the SolidNetWork License File wizard.
j) Click Finish.
A SolidNetWork License File Wizard warning appears.

k) Click OK to exit the SolidNetWork License File wizard and then Finish to exit the
SolidNetWork License Manager.

If you are configuring the second triad license manager computer, repeat this process
for the third triad license manager computer.

Using SolidNetWork Licenses with Firewalls
If your computer uses a firewall, you must configure ports to support SolidNetWork
Licensing.

In the firewall software, you must add two SolidNetWork License ports (for example,
SNL-in-port and SNL-out-port) to the firewall exceptions list. For details about
configuring these ports, consult with your system administrator.

If you are using Windows Firewall on Windows XP SP2 and Windows Server 2003 SP1,
you must modify ports on the SolidNetWork license manager computer and modify the
SolidNetWork license file to distribute licenses to the license client computers.
Modifying License Manager Computer Ports for Windows Firewall
If you are using Windows Firewall, you must modify firewall port settings on the
SolidNetWork license manager computer.

1. In Windows, open the Control Panel and then double-click Security Center.
2. Click Windows Firewall.
3. On the Exceptions tab, click Add Port.
4. Type a Name (for example, SNL-in-port) and a Port Number (for example, 25734)

and then click OK.
5. For the second port, click Add Port on the Exceptions tab again, specify the other

port's name and number (for example, SNL-out-port and 25735), and then click OK.
You will reference this port number when modifying the SolidNetWork license file.
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If you use Workgroup PDM, you must modify Workgroup PDM port numbers in
Windows Firewall. Typically, these ports are 20000 (VaultAdmin), 30000 (Data),
40000 (Request), and 80 (Viewer).

6. Close Windows Security Center and Control Panel.

Modifying SolidNetWork License Manager Settings for Windows Firewall
If you are using Windows Firewall, you must modify the SolidNetWork license file to use
the firewall ports to distribute licenses to the license client computers.

1. Start the SolidNetWork License Manager.
2. On the Server Administration tab, under License Server, click Stop. (Click Yes when

prompted for confirmation and OK to complete stopping the license server.)
3. Under License Information, click Modify.
4. Under Server Type, select the server arrangement for your network (Single or

Triad) and then click Next.
5. Under Server Information:

a) Select A firewall is in use on this server.
b) Port Number and Vendor Daemon Port Number should contain the port numbers
specified for the Windows Firewall (for details, see Modifying License Manager
Computer Ports for Windows Firewall on page 63).

c) Click Next and then click Finish.

6. On the Server Administration tab, under License Server, click Start.
7. Click OK to close the SolidNetWork License Manager.

SolidNetWork License Administration
Tasks include starting, upgrading, and uninstalling the license manager, and retrieving,
borrowing and returning licenses.

Starting the SolidNetWork License Manager
You can start the SolidNetWork License Manager from the Windows Start menu.

In Windows, click Start > All Programs > SolidWorks version > SolidNetWork
License Manager > SolidNetWork License Manager.

Upgrading the SolidNetWork License Manager
For major releases of SolidWorks, upgrading the license manager consists of uninstalling
the old license manager, installing a new one, and re-activating the SolidNetWork license.

The license manager for a newer release can distribute licenses for client computers
remaining at the previous release as well.

1. Start the SolidNetWork License Manager to verify that no client computers on the
network are running SolidWorks.
The License Usage tab shows clients running SolidWorks.

2. Uninstall the old license manager.
3. Install the new license manager and re-activate the SolidNetWork license on the

license manager computer.
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If you are upgrading the SolidNetWork License Manager on a computer that also runs the
SolidWorks application, upgrade SolidNetWork license managers and clients before
installing any new SolidWorks application service packs on that computer.

If you are upgrading the license manager on a computer that hosts administrative images,
upgrade the license manager before upgrading the administrative images.
Uninstalling the SolidNetWork License Manager
When upgrading the SolidNetWork License Manager, you must uninstall the old license
manager before installing the new one.

1. Start the SolidNetWork License Manager.
2. Verify that no client computers on the network are running SolidWorks.

The License Usage tab shows clients running SolidWorks.

3. If you wish to transfer the SolidNetWork license to another computer, transfer the
license to that computer before removing the SolidNetWork License Manager from
this computer.

For information about transferring SolidNetWork licenses, see Transferring a
SolidNetWork License on page 58.

4. On the Server Administration tab, under License Server, click Stop.
5. Click OK to exit the license manager.
6. In Windows, open Control Panel > Add or Remove Programs.
7. Select SolidWorks SolidNetWork License Manager, click Remove, and confirm

the deletion.
8. In Windows Explorer, delete the SolidWorks SolidNetWork License Manager folder.

(Typically, this folder is located under Program Files in the SolidWorks installation
directory.)

You now are ready to install a new version of the license manager.

Deleting SolidNetWork License Files
Delete old and expired SolidNetWork license files before upgrading to new ones.

1. Start the SolidNetWork License Manager.
2. On the Server Administration tab, under License File, click Modify, and then click

Next until you reach the Licenses screen.
3. On the Licenses screen, select the old or expired SolidNetWork license file, then click

Remove.
4. Click Finish and then click OK.

Retrieving Client Licenses
To terminate a client SolidNetWork connection, a system administrator can stop the
license and return it to the free license pool.

• The client must have been connected to the license manager for at least two minutes.
• You can configure the SolidNetWork timeout feature to be the 15-minute minimum.
After 15 minutes of idle time, that license is returned to the free license pool.

For details, see
SolidNetWork_License_Manager_install_dir\Docs\flexuser\licensingenduserguide.pdf.
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1. Click Start > Run, type cmd, and then click OK to open a Windows command window.

2. In the command window, enter:
cd SolidNetWork_License_Manager_install_dir\utils
lmutil lmremove feature user computer display

where feature, user, computer, and display are the terms shown on the License Usage
tab of the SolidNetWork License Manager.
For example:

lmutil lmremove solidworks carlos designcmp1 corpserver

You must terminate the license for each add-in product (PhotoView 360,
FeatureWorks, etc.) separately.

Borrowing and Returning SolidNetWork Licenses
You can borrow a SolidNetWork license to use the software from a remote location. Since
the license is removed from the pool of available licenses, a borrowed license must be
returned for it to become available again.

Borrowed licenses are valid only for the system on which they were borrowed; they
cannot be transferred.

The license is lent for a specified period of time, up to 30 days (or as defined by the
system administrator), and the license is removed from the pool of available licenses.

System administrators can customize borrowing to:

• Define users or groups that are allowed to borrow licenses
• Set the number of licenses that cannot be borrowed

For details, see
SolidNetWork_License_Manager_install_dir\Docs\flexuser\licensingenduserguide.pdf.

Borrowing SolidNetWork Licenses
You can borrow a SolidNetWork license to use the software from a remote location.

You must be connected to the SolidNetWork license manager to borrow the license, but
not necessarily to use it.

1. Start the SolidNetWork License Manager.
2. On the License Borrowing tab:

a) Select a date in Borrow until.
b) Select the products to borrow, then click Borrow, and click Yes to confirm.
c) Click Refresh. The Expire Date column indicates when licenses are due back.

3. Click OK.

To run SolidWorks, you must borrow a SolidWorks license. SolidWorks Professional
and SolidWorks Premium enable only the add-ins associated with the package, but
not SolidWorks.

Returning a Borrowed SolidNetWork License
Since a borrowed SolidNetWork license is removed from the pool of available licenses,
that borrowed license must be returned for it to become available again.
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1. Start the SolidNetWork License Manager.
2. On the License Borrowing tab:

a) Select the products to return, click Return, and then click Yes to confirm.
b) Click Refresh. The Expire Date column becomes blank, indicating that the licenses
have been returned.

3. Click OK.

It is not necessary to return licenses after the expiration date. The license is returned
to the pool on the SolidNetWork license manager at midnight on the expiration date
and the applications on the remote system no longer run.

Monitoring License Idle Time
SolidWorks can register idle time with the SolidNetWork License Manager so that licenses
that have not been used for a certain amount of time are returned to the free license
pool.

1. In the SolidNetwork License Manager installation directory, create a text file:
SolidNetWork_License_Manager_install_dir\Licenses\sw_d.opt

2. Add the following line to the file:
TIMEOUTALL seconds

where seconds is a number greater than or equal to 900 (15 minutes), which is the
minimum time allowed.

Installing Temporary Licenses
The temporary "ANY" license can be used temporarily when the original SolidNetWork
license is not available.

By installing the "ANY" license file, you agree to implement the traditional license
upon receipt of a SolidNetWork license from Dassault Systèmes SolidWorks
Corporation. Compliance with license restrictions still is required.

To install an "ANY" license:

1. If you are an existing SolidNetWork user, uninstall the SolidNetWork License Manager
and delete the installation folder.

2. Start SolidWorks Installation Manager (as described under Initiating SolidWorks
Installation on page 6).
a) For type of installation, select the following:

• Administrative Image and Server products
• Install SolidNetWork License Manager (distributed licensing) on this
computer

b) For serial number, provide the SolidNetWork License serial number.
c) Follow the online instructions to complete the installation in SolidWorks Installation
Manager.

3. Start the SolidNetWork License Manager (Start > Programs > SolidWorks version
> SolidNetWork License Manager > SolidNetWork License Manager).

4. If you are prompted to activate, click No.
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The Server Administration tab of the SolidWorks SolidNetwork License Manager
appears.

5. Under Advanced Options, click Options.
The Advanced Options dialog box appears.

6. Under SolidNetWork Server License Mode, click Use a License File and click OK.
The Advanced Options dialog box closes.

7. Under License Information, click Modify.
The SolidNetWork License File Wizard appears.

8. Under Server Type, select Single and click Next.
9. When you see this message:

Could not read the dongle ID number.

click Cancel.

The ID "ANY" appears automatically.

If your computer uses a firewall, you might have to make some additional
specifications on this screen. For more information, see Using SolidNetWork
Licenses with Firewalls on page 63.

10. Continue with the installation.

Upgrading from Individual Licensing to SolidNetWork Licensing
You can upgrade a computer from individual SolidWorks licensing to SolidNetWork licensing
by specifying the SolidNetWork license serial number in SolidWorks Installation Manager.

If a computer does not have SolidWorks installed, you can specify SolidNetWork licensing
by entering the SolidNetWork serial number when installing with SolidWorks Installation
Manager.

If a computer already has SolidWorks installed and you are switching from individual
licensing to SolidNetWork Licensing, you can Modifying an Installation on page 10 for the
client computer and specify the SolidNetWork License serial number in place of the
individual license serial number when running SolidWorks Installation Manager.

Using SolidNetWork Licenses with Add-in Products
You can use the SolidNetWork License Manager to distribute licenses for SolidWorks core
add-in products (such as FeatureWorks, Workgroup PDM Server, and so on).

• An equal number of SolidWorks software licenses and SolidWorks add-in licenses is
not required.

• To check out a license for an add-in product, you first must check out a license for
SolidWorks.

• To borrow an add-in product license, you must borrow both the SolidWorks software
license and the SolidWorks product license that includes the add-in. For example, for
PhotoWorks you would borrow either a SolidWorks Professional or SolidWorks Premium
product license.

• To release an add-in product license:

• In SolidWorks, click Tools > Add-ins and clear the add-in.
• Exit SolidWorks.
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Using the Same Computer for the License Manager and Administrative Image
Installations
You can configure one computer on a network to act both as a license manager distributing
SolidNetWork licensing and as an administrative image location from which users can
install SolidWorks software.

Client computers can obtain licenses from the license manager and then install SolidWorks
from the same computer.

This configuration requires that the license manager and administrative image be
installed on the same computer. Install the license manager first and then create
and deploy the administrative image.

FLEXnet Publisher License Management
SolidNetWork Licensing is based on FLEXnet Publisher® license management.

For more information about FLEXnet Publisher license management, see the FLEXnet
Publisher License Administration Guide in the SolidNetwork License Manager installation
directory (
SolidNetwork_License_Manager_install_dir\Docs\flexuser\licensingenduserguide.pdf).

For the latest information about FLEXnet Publisher license management, contact Acresso®

Software.
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Troubleshooting
Consult these topics to assist you in troubleshooting installation problems.

Installation Manager Log Files
The Installation Manager log files are available to assist you in troubleshooting installation
problems.

The Installation Manager log files are located with the other SolidWorks application log
files.

• For Windows Vista or later:

C:\Users\username\AppData\Roaming\SolidWorks\Installation
Logs\installed_version

• For Windows operating system versions prior to Vista:

C:\Documents and Settings\username\Application Data\SolidWorks\Installation
Logs\installed_version\

To see the log file directories, you might have to configure the Windows Folder
options to Show hidden files and folders.

If the application data is located on a drive other than C:, adjust the directory path
accordingly.

This directory contains the SummaryIMLog_nnnnn_nnnnn_nnnn_nnnnn.txt file, a general
log of the Installation Manager progress.

The Other Logs subdirectory contains more detailed installation log information.

SolidWorks Installation Manager Download Folder
The SolidWorks Installation Manager can download the installation files it needs to a folder
that you specify. This topic provides answers to frequently asked questions about the
download folder.

1. How do I install the files in this folder? on page 71
2. Can I install MSI files manually from this folder using msiexec or some other application?
on page 71

3. Can I select the same download folder for each version I install? on page 71
4. I downloaded some products manually from the Dassault Systemes SolidWorks
Corporation Web site. Can the Installation Manager install these? on page 71

5. Can the files I download be shared by other users? on page 71
6. How do I know when a new version of SolidWorks products becomes available? on
page 72

7. The Installation Manager shows only SW2006 or SW2007 installs, but not the current
version. on page 72

8. The Installation Manager does not let me select a different service pack of a product
to install. on page 72

9. The Installation Manager is prevented from downloading files. on page 72
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10. Not all of my SolidWorks products are updated to the latest service pack, but Check
For Updates tells me I have the latest version? on page 72

11. Can I copy a DVD to a download folder? on page 73

How do I install the files in this folder?
Run setup.exe. You may still be required to download some files if you select to install
items that were not downloaded previously.

Do not install using msiexec (see below).

Back to Top

Can I install MSI files manually from this folder using msiexec or
some other application?
No. The Installation Manager does not download some files that would be required when
running msiexec.

Back to Top

Can I select the same download folder for each version I install?
Download folders are version-specific. Starting in SolidWorks 2010, SolidWorks Installation
Manager automatically creates a version-specific sub-folder within the specified folder.

Back to Top

I downloaded some products manually from the Dassault Systemes
SolidWorks Corporation Web site. Can the Installation Manager
install these?
Starting in SW2009, files downloaded manually can be used by the Installation Manager.
However, it is better to run the Installation Manager, selecting the option to download
files. The Installation Manager shows which files you need based on what you are installing,
providing links to download each file. This option can be used when the built-in download
page does not work (most likely because of downloading restrictions enforced by a proxy
server).

If Microsoft Internet Explorer asks whether you want to save or run files during a
download or installation, always specify save.

Back to Top

Can the files I download be shared by other users?
Yes. To do so, download to a network share. Each client can then run the Installation
Manager from the share to install.

No further downloads will be required unless a user selects some items to install that
were not selected during the initial download or if a computer that uses this download to
install has a different set of prerequisites than the computer to which you downloaded
the files.

If you are downloading on behalf of others but are not installing, select the Download
Only option when installing. This option will allow you to select products regardless of
what may be installed on your system. However, this option cannot be used to download
patches or to create administrative images.

Back to Top
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How do I know when a new version of SolidWorks products
becomes available?
You will be informed when a new version is available in the following cases:

• If you run Check for Updates ( Start > All Programs > SolidWorks Installation
Manager > Check For Updates)

• If you previously scheduled a Check for Updates and run SolidWorks
• If you select an installed version of SolidWorks in Windows Add/Remove Programs
and click Change

• If you run an older version of the Installation Manager (sldIM.exe) from a download
folder

In these cases, you may select to download the newer version. The Installation Manager
will download and run the newer version of itself, and not any installation files. After the
newer version of the Installation Manager runs, you may select a set of installation actions.
The Installation Manager will then determine which installation files are needed (and not
downloaded previously) and will offer to download those files.

Back to Top

The Installation Manager shows only SW2006 or SW2007 installs,
but not the current version.
You are running an older version of the Installation Manager that is no longer supported
for the current release. It can only download service packs for SW2006 and SW2007
versions.

Back to Top

The Installation Manager does not let me select a different service
pack of a product to install.
That is by design. Each Installation Manager is built only to install a specific version of
SolidWorks products. If you want to install a different service pack, you need to run that
version’s Installation Manager. To find the latest version available, see How do I know
when a new version of SolidWorks products becomes available? on page 72

Back to Top

The Installation Manager is prevented from downloading files.
If proxy server restrictions prevent applications from downloading files, the Installation
Manager cannot download files automatically.

You can download files manually and then install them using the Installation Manager.
Select the option in the Installation Manager to download individual files (for example,
Conduct manual download on the Download Options page). Based on your product
selections and system requirements, a web page appears in a separate window containing
links to download all required files manually. These links are identical to those provided
by the SolidWorks Customer Portal, but you do not need to search for the files.

Back to Top

Not all of my SolidWorks products are updated to the latest service
pack, but Check For Updates tells me I have the latest version?
Check For Updates only tells you whether you have installed (or are running) the latest
version of the Installation Manager.
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If you want to update all products to the latest version that is installed, in Add/Remove
Programs, select the latest installed version of SolidWorks and click Change.

Back to Top

Can I copy a DVD to a download folder?
Yes, but installations may fail unless you copy the entire contents of each DVD released
for that platform (x86 or x64). The Installation Manager looks for the files swdata*.id
to determine the version. If these files are not present, it will fail to recognize any of the
installation files that you copied and will require that they be downloaded.

Back to Top

Troubleshooting SolidNetWork Licenses
If the SolidNetWork License Manager installation fails, check for these possible
explanations.

Accessing the SolidNetWork License log files
When a license error occurs, the answer often appears in the
SNL_Manager_install_dir\lmgrd.log file.

Could not obtain a license for SolidWorks. Cannot connect to license
server.
Typically, this problem is caused by port settings.

• Port settings between the SolidNetWork license manager and the license client might
not match.

• Additional port settings for multiple versions of SolidNetWork license managers might
not have been specified.

For details about port settings for SolidNetWork license managers and clients, see Using
SolidNetWork Licenses with Firewalls on page 63.

Troubleshooting Upgrades
If you encounter problems while upgrading to a new SolidWorks release, check for these
possible explanations.

Upgrading from a Source That Has Moved
When SolidWorks is installed, the Installation Manager remembers the location of the
installation sources (disk media, disk image on a network, etc.). It expects the sources
to be available at the same location when updating.

If the source moves or is deleted, or if the source media changes, the Installation Manager
produces an error message. However, you can continue the upgrade by browsing to
another location as long as it contains all the same file and folder structure.
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SolidWorks Installation Manager
Application Help

The SolidWorks Installation Manager is a standalone application that installs and updates
your SolidWorks products.

You can run the Installation Manager:

• From a SolidWorks DVD or a shared source or download folder (when installing a new
version)

• From the Control Panel Add or Remove Programs page (when modifying or removing
an existing version)

• Through a scheduled or manual update check (when detecting, downloading, and
installing new release versions)

Each version of SolidWorks has an Installation Manager specific to that version.

For versions prior to SolidWorks 2008, use the SolidWorks 2007 Installation Manager
or download product versions manually from the SolidWorks Support Web site.

Check for Updates Results
Check for Updates looks for later versions of SolidWorks.

You can run Check for Updates manually:

• In Windows, click Start > Programs > SolidWorks Installation Manager > Check
for Updates

• In SolidWorks, click Help > Check for Updates.

Check for Updates is not available on clients installed from administrative images.

Check for Updates can run automatically as a result of configuring a SolidWorks installation
option.

Newer Version Available
Installation Manager has detected a newer version of SolidWorks products. You can update
to a newer version by selecting the Installation Manager for that version.

This newer version can download installation files based on the products you specify in
the installation. You can share the downloaded files with other users who install using
the Installation Manager.

These downloads are only for use by the Installation Manager.

These options are available:

• If there are multiple versions available, you can select a version from the list.
• For details about this version, click Check to see what this upgrade includes.

Clicking Next obtains and runs the selected version of the Installation Manager.
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No New Downloads Available/Unable to Check for New Versions
Installation Manager has not found a newer version of SolidWorks products, either because
you are installing the latest version available or because it could not connect to the
SolidWorks site to check.

Scheduling Automatic Update Checks
You can schedule future update checks by selecting Check for updates every ___ days
and specifying the frequency of the update check.

The automated update check runs when you start SolidWorks.

Client Administrative Options
Specify administrative options for the client installations running from an administrative
image.

Creating a Diagnostic Log
Creating a diagnostic log during client installation helps troubleshoot installation problems.
However, the client installations are slower.

Running the Installation as a Different User
Enter a user name and password to run the installation as a user other than the one
currently logged in.

For example, if your users do not have administrative privileges, you can create an
administrative account with full privileges on each client computer and specify it here.

This feature is not supported on Windows Vista or later.

Running a Program Before or After Installation
Browse to the program to run before or after installation.

Use this option to instruct the administrative image installer to run the script before
beginning the installations or after the installation completes.

SolidWorks Customer Experience Program
Specify whether you want the client to participate in the SolidWorks Customer Experience
Program.

Performance information is sent to SolidWorks Corporation to help improve the product.
The process is transparent.

SolidWorks uses this information to determine trends concerning product usage and
quality. Our goal is to deliver the highest quality product and the performance logs are
a useful tool in this process.

All information contained within the log files is treated confidentially. It is not used for
any other purpose and no one will contact you.

For further information, see
http://www.solidworks.com/pages/services/CustomerExperienceFeedbackProgram.html.
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Client Installation Options
When creating an administrative image, you can specify how the client installations are
to be run.

Client Installations of Major Versions
When installing a new SolidWorks major version, the client installation can do one of the
following:

• Upgrade the latest existing major version, if one exists
• Create a new major version (click Browse to change the new installation directory)

If you specify that the client upgrades the latest existing major version, the older version
will no longer be available after the upgrade.

If you specify that the client create a new major version, the existing major version is
preserved on the client computer after the installation. You can specify a default location
for the new major version installation.

If this is a Service Pack release of an existing major release, that major release
installation is always updated to the Service Pack. (That is, Installation Manager will
not create a new installation for a Service Pack if the major release for that Service
Pack is already installed.)

Installed products other than SolidWorks are not affected by this selection.

For some Service Pack updates, Installation Manager installs new versions of those
products if they were not installed previously.

Applying SolidWorks Settings
You can specify one of the following:

• Allow client installations to use their current SolidWorks settings.

(If none exist, the installation will use the default SolidWorks settings for that release.)

• You can use settings exported from the Copy Settings Wizard. Click Browse to find
an existing Copy Settings Wizard settings file.

If SolidWorks is installed on this computer, you can run the Copy Settings Wizard by
clicking Run Copy Settings Wizard Now.

You can run the Copy Settings Wizard on other computers that have SolidWorks
installed by clicking Start > Programs > SolidWorks version > SolidWorks
Tools > Copy Settings Wizard.

Activating Client Installations
You can specify that client licenses are activated automatically when the client installation
completes, or you can leave it to the users to do manually after installation.

This option is available only if both of the following are true:

• You entered one or more non-SolidNetWork License serial numbers.
• One or more products requiring activation were selected for installation.

76



Download Options
Specify details for completing the download operation, such as the location of the
downloaded files, how to download the files, and whether to install the downloaded files.

SolidWorks Installation Manager supports electronic software distribution (ESD). If you
are not installing from a SolidWorks DVD, you are prompted to specify the source for the
SolidWorks products you are installing.

For answers to questions about the download folder, see SolidWorks Installation
Manager Download Folder on page 70.

What do you want to do?
Choose one of the following:

After the download completes, Installation Manager runs an
installation using the downloaded files.

Download and
install/Download
and create image

Installation Manager does not run an installation after the download
completes.

Typically, you would specify this option if you are downloading the
files to configure an installation file set to share among multiple
computers.

Download only.
You can download
once and then
share downloaded
files with multiple
computers.

If you specify this option, you are then asked to choose between
two sets of files to download:

• Files for THIS computer: The download will contain only those
files that are missing from the installation file set currently on
this computer.

This should be a smaller download because it contains:

• Only files for products selected on the Product Selection page
• Only the prerequisite files that are required for your computer
but not yet installed

However, if you try to use this downloaded file set on another
computer to perform an installation, some files could be missing
(because the installation file set on the other computer might be
different from this one). You can use these download files to
install on another computer, but when the installation runs you
may have to download additional files to complete the installation
file set on that computer.

• Files to share with ANY computer: The download will contain
the complete installation file set that can be used to install this
version on any computer.

This will be the larger download because it contains the complete
file set that you can use to install this version of any product on
any computer.

If you specified a limited set of products to download, this option
ignores that specification and downloads all products contained
in the product release.
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The download will contain all files required to create an
administrative image, not just those files required to perform an
individual installation.

Installation Manager does not download any files, but uses the files
in the selected directory.

Click Browse to navigate to a different location. For example, you
can browse to an installation DVD or a download folder, provided
that location contains all the required files.

Install
only/Create
image only. I
already have all
the installation
files needed.

If you receive an error message that the folder is incomplete, and
you were expecting all installation files to be present at that location,
possible explanations include:

• You selected a component for installation that had not been
downloaded previously or it was selected by default.

• The files were downloaded on another computer with a different
set of system requirements.

• You previously performed a client installation and now are
creating an administrative image, which requires a larger file set.

You can either browse to a folder containing all the files (for
example, a DVD) or select one of the download options.

Where do you want to download the required files?
This is the download folder location.

In some cases, this option might be visible but disabled. For example, if Install only is
specified, the Installation Manager will install any downloaded files from the directory
specified for that option, rather than using a separate download folder.

Whether you are downloading these files or accessing them from your own location,
all files must be downloaded to the same download folder.

Estimated download size
The estimated download disk space requirements are based on the complete component
listing chosen, regardless of whether this is a new download or you are resuming a
download from a previous session.

For example, if you are resuming a previous download the Installation Manager processes
only those files that have not already been downloaded. The download time could be less
than the estimate.

If a file completed downloading in the previous download, its size is not included in this
estimate. Therefore, the estimate might be higher than the actual download size.

How do you want to download?
There are two options:

In some cases, a proxy server might prohibit automatic downloads
from Installation Manager.

Conduct manual
download

By selecting this option, you can download the files manually
through a Web page and then proceed within Installation Manager
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to complete the installation operations. This Web page is
customized by Installation Manager to download only the files
required to complete the installation.

The downloader uses an algorithm to increase the speed of the
download by increasing the network bandwidth used during the
download.

In some cases, this can disturb network performance. If you have
trouble downloading, this option might not be supported by the

Speed up
downloads by
using more
network
bandwidth

proxy server. Try clearing the option and attempting the download
again. For details, check with your network administrator.

This option applies only to automatic downloads. It has no
impact on manual downloads.

Download Options for Installation Manager Files
You have chosen to download a later version of the SolidWorks Installation Manager. Use
this screen to specify where and how it is downloaded.

For answers to questions about the download folder, see SolidWorks Installation
Manager Download Folder on page 70.

This screen appears only if there is a problem with the default download folder (for
example, if write access or network access is not available). Typically, you can just specify
an alternate download directory to proceed.

Download Directory
Browse to the destination for the Installation Manager files.

The size of the download and the amount of space needed is shown. The amount of space
needed includes extra space required to unzip certain downloads and is larger than the
actual download size.

Use Download Acceleration
If you choose this option, the downloader uses an algorithm to increase the speed of the
download.

Download acceleration increases bandwidth and can disturb network performance.
Check with your network administrator before enabling download acceleration.

If download acceleration is not supported by the proxy server, this option is automatically
disabled.

Download Product Installation Files
Specify where and how to download missing files for the specified product.

The Installation Manager downloads, verifies, and extracts all files in parallel during the
download process.
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Cancelling out of this screen cancels the rest of the installation sequence.

For the consequences of cancellation and instructions on completing interrupted
installations, see Installation Errors.

Download Directory
Browse to the destination for the downloaded files.

The download size and the required space is shown. The required space includes any
extra space needed to unzip certain downloads and is larger than the actual download
size.

For answers to questions about the download folder, see SolidWorks Installation Manager
Download FolderThe SolidWorks Installation Manager can download the installation files
it needs to a folder that you specify. This topic provides answers to frequently asked
questions about the download folder. .

Download Options

The downloader uses an algorithm to increase the speed of the
download by increasing the network bandwidth used during
the download.

In some cases, this can disturb network performance. If you
have trouble downloading, this option might not be supported

Speed up downloads
by using more
network bandwidth

by the proxy server. Try clearing the option and attempting
the download again. For details, check with your network
administrator.

Download acceleration increases bandwidth and can disturb network performance.
Check with your network administrator before enabling download acceleration.

If download acceleration is not supported by the proxy server, this option might be
automatically disabled.

Download Progress
The Installation Manager downloads, verifies, and extracts all files in parallel during this
process.

To cancel the download after it has begun, click Cancel.

If you cancel the download or the download fails, a Download Canceled or Download
Problem screen indicates which downloads were not completed and lets you resume the
download or close the application.

For answers to questions about the download folder, see SolidWorks Installation
Manager Download Folder on page 70.

Download Results
Indicates whether the download completed successfully, failed during operation, or was
cancelled.
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Download Problem/Download Cancelled
If you see Download Problem, Installation Manager encountered problems that prevented
the download from completing.

If you see Download Cancelled, you cancelled the download before it could complete.

To proceed:

To resume the automatic download from when you cancelled,
select this option and click Retry Download or Resume
Download.

Retry/Resume
automatic downloads

In some cases, a proxy server might prohibit automatic
downloads from Installation Manager.

Download files
individually in a Web
browser By selecting this option, you can download the files manually

through a Web page and then proceed within Installation
Manager to complete the installation operations. This Web
page is customized by Installation Manager to download only
the files required to complete the installation.

Download Complete
The Download Complete screen appears when the download completes if you specified
the Download Only option.

Click Finish to exit Installation Manager.

Do not attempt to install any of these products manually. Always use Installation
Manager to install downloaded files.

Installation Errors/Installation Cancelled
The installation has encountered an error or was cancelled.

If an error or cancellation occurs:

• Products that installed before the error or cancellation remain on the computer.
• The product that was being installed at the time of the cancellation is rolled back, if
possible, so that there are no partial installations.

• Remaining products are not installed or uninstalled. A list is provided under Not Yet
Attempted.

To resume installing or uninstalling these products, click the link provided.

The installation manager first installs any prerequisites that are not installed on the
computer, such as .NET framework. It then installs the selected products in this
order:

1. SolidWorks
2. eDrawings
3. SolidWorks Search
4. DWGeditor
5. SolidWorks Explorer/Workgroup PDM
6. PhotoView 360
7. SolidWorks Flow Simulation
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8. COSMOSM

Recovering from a Failed or Cancelled Installation
If an error or cancellation occurs during installation, you can recover from that point by
re-running the installation.

1. Record the error message and product code for the installation that failed, as shown
on the Installation Errors or Installation Cancelled screen.

If you are prompted for a source file and you are not modifying an existing
SolidWorks installation, the installation or computer may be corrupt. Contact
your SolidWorks reseller.

2. Reboot the computer.
3. To ensure that no SolidWorks products are running, in Windows, press Ctr+Alt+Del

to open the Task Manager.
4. On the Processes tab, if any of the following processes appear under Image Name,

select them and click End Process.

• SLDWORKS.exe
• EModelViewer.exe
• DWGEditor.exe
• PDMworks.exe
• pdmwVault.exe
• SWViewer.exe
• solidworksexplorer.exe
• swlmwiz.exe
• photoview360.exe
• SWBoengine.exe
• SWVBAServer.exe
• Sldshellextserver.exe

5. If the application is already installed and you were trying to modify or remove it, try
to repair the installation.

6. Click Start > Control Panel > Add or Remove Programs.
7. Select the version of SolidWorks that failed.

If there is no entry for the SolidWorks version you are trying to install, repeat
the installation process.

8. Do one of the following:

• To retry, click Change and select all products that failed to install or were skipped
during the installation.

• To skip the failed installation, click Change and select all products that were
skipped during the installation. Clear the product that failed to install.

• To abandon the installation, click Remove and select any products that were
installed.

This will not restore the previous version of any products you are upgrading.
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Repairing the Installation
If an error or cancellation occurs during installation, you can use Windows Control Panel
to repair the installation.

You can repair an individual installation. You cannot repair an administrative image
installation; you must uninstall and then reinstall the administrative image.

To repair the installation:

1. In Windows, click Start > Control Panel > Add or Remove Programs.
2. Select the version of SolidWorks that failed and click Change.

SolidWorks Installation Manager starts.
3. In the welcome screen, click Repair the individual installation (on this computer).

and click Next.
4. Select the products that failed to install or remove and click Repair.

Contacting the SolidWorks Reseller
If modifying or repairing the installation fails, contact your local SolidWorks reseller with
the information gathered from this screen. You might also be asked to provide a zip file
of the Installation Manager log files.

1. Locate the log files:

• For Windows operating system versions prior to Vista:

C:\Documents and Settings\username\Application
Data\SolidWorks\Installation Logs\installed_version\

• For Windows Vista or later:

C:\Users\username\AppData\Roaming\SolidWorks\Installation
Logs\installed_version\

If you cannot find the folder, it might be hidden. In Windows Explorer, click
Tools > Folder Options. On the View tab, under Advanced Settings, select
Show hidden files and folders for Hidden files and folders.

2. Zip the entire contents of this folder, including sub-folders.

Installation Is Complete
The Installation Manager has completed its processing.

One or more of these options may be displayed.

Updates
The option to check for updates is available for individual installations. To specify frequency
of checks, select Check for Updates every ___ days, and provide a value.

You must be connected to the Internet when the check is performed.

If an update is found at the scheduled time, you are notified the next time you run
SolidWorks.
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For administrative image installations, upgrades are managed by administrators.

Service packs are available for subscription customers.

What's New
For individual installations, when you finish the installation process, a document describing
new functionality in SolidWorks and its add-in products appears.

For administrative image installations, the document appears on client computers when
they complete their installations.

Survey
Give us your opinions about the installation process by answering a short survey.

Customer Experience Program
Performance information is sent to SolidWorks Corporation to help improve the product.
The process is transparent.

SolidWorks uses this information to determine trends concerning product usage and
quality. Our goal is to deliver the highest quality product and the performance logs are
a useful tool in this process.

All information contained within the log files is treated confidentially. It is not used for
any other purpose and no one will contact you.

For administrative images, you specify this in the Client Administrative Options screen in
the Summary page.

For further information, see the Customer Experience Feedback Program Web site.

Administrative Image Creation Is Complete
When you finish creating an administrative image, the only options that appear are:

Display instructions on using administrative images to
install SolidWorks on multiple client computers.

Show me how to install
this image on a client.

Start the Administrative Image Option Editor for the
administrative image that was just created.

For details about configuring an administrative image using
the Option Editor, see Administrative Image Option Editor
on page 15.

Start the Option Editor
now.

Checking for Updates to SolidWorks
You can use SolidWorks Installation Manager to check for updates manually or to configure
automatic periodic checking for updates.

1. Start the Installation Manager by doing one of the following:

• In the SolidWorks application, click Help > Check for Updates.

• In Windows, click Start > Programs > SolidWorks Installation Manager >
Check for Updates.

Installation Manager tells you whether any updates are currently available.
2. If updates are available, choose whether to download and install them.
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3. To enable automatic periodic checks for updates, when Installation Manager completes
its processing select Check for Updates every __ days and specify the frequency
of checks.

Installation Location
Specify SolidWorks installation locations.

For installations except administrative image creation, these options apply:

This is the directory location to which you are installing
SolidWorks.

Install selected
products to

When upgrading or modifying an installation, all files must
be installed to the existing location for that installation. In
this case, you cannot change the location of the existing
SolidWorks installation.

This is the additional space required for the products selected
for installation or modification.

Estimated space
required for
installation Verify that the disk to which you are installing has sufficient free

space to support the installation requirements.

This is the directory location from which you are installing
SolidWorks.

Install from

This option appears only if the Install Only option is
specified. For details, see Download Options on page 77.

Consult your system administrator before changing either SolidWorks installation
location.

Administrative Image Locations
When creating an administrative image, these options apply:

This is the directory location in which Installation Manager will
create the new image.

New image location

This location cannot contain an existing administrative
image.

This is the additional space required for the administrative
image.

Estimated space
required for image
creation Verify that the disk to which you are installing has sufficient

free space to support the image requirements.
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This is the directory location from which you are installing
SolidWorks products.

Create image from

This option appears only if the Install Only option is
specified. For details, see Download Options on page 77.

When upgrading an existing administrative image, Installation
Manager creates a new image based on the settings for that

Existing image
location

existing image. This existing image is not modified. This shows
the location of the original image you specified on the Welcome
screen.

Avoid Using Version-Specific Directory Paths
If you specify a version number in an installation directory location (for example,
C:\Program Files\SolidWorks Corp\SolidWorks 2009\), and then upgrade that
installation to SolidWorks 2010, you will have a SolidWorks 2010 installation directory
that is labeled SolidWorks 2009.

Installation Options
One or more older major versions of SolidWorks are currently installed on this computer.
Choose whether to upgrade the latest existing version to the new version or to create a
new installation for the new version.

This choice appears only if no previous version of this major release is installed on
this computer. If a previous version of this major release is installed, SolidWorks
Installation Manager always updates that installation.

(Starting in SolidWorks 2010, parallel installations of multiple Service Pack versions
of the same major release are no longer supported.)

When upgrading:

• All specified products are upgraded.
• All installed products are selected by default.
• If you deselect a product, that product is not upgraded.

If you deselect a product component, you are not specifying that Installation
Manager remove that component. To remove a product component, use
Add/Remove Programs, as described under Removing an Installation on page
48.

Select the appropriate option and click Next to continue.

Create a new installation of SolidWorks version.
Selecting this option preserves the older major version installation in addition to creating
a new installation for this major version.

This can be useful if you want to access the older version of SolidWorks even after
the newer version is installed. For example, if you are sharing files with other users
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who are still running the older version, you can avoid version incompatibility with files
saved using the newer version.

Upgrade SolidWorks previous_major_version to SolidWorks
current_major_version.
Selecting this option upgrades the older version installation to the newer version.

Once the installation completes, the older SolidWorks version will no longer be
available on this computer.

Installation Progress
This screen shows the progress of the installation.

To cancel the installation after it has begun, click Cancel.

For the consequences of cancellation and instructions on completing interrupted
installations, see Installation Errors/Installation Cancelled on page 81.

Installation Type
Specify the installation operation you would like to run, such as creating a new installation,
modifying or repairing an existing installation, creating an administrative image, installing
administrative server products, or downloading files without installing.

Individual
Install SolidWorks products on this computer.

This option appears only if this version is not currently installed on this computer.

Modify the individual installation
Modify the existing SolidWorks installation on this computer.

This option appears only if this version is currently installed on this computer.

Modifications include:

• Adding or removing SolidWorks product components
• Changing to a different SolidWorks package (for example, SolidWorks Professional,
SolidWorks Premium, and so on)

• Changing the SolidWorks serial number setting

If you already specified a SolidWorks serial number during a prior installation, the
Installation Manager might not prompt for it again. To change the serial number
that is assumed by the Installation Manager, you must select this option.

Repair the individual installation
Repair the existing SolidWorks installation on this computer.
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This option appears only if this version is currently installed on this computer.

Repair verifies that all the files are present and registered properly and fixes any problems
that are found. Data you have created is not affected.

• To repair a product, ensure that it is selected.
• Clear the check boxes for products you do not want to repair.

You can repair an individual installation. You cannot repair an administrative image
installation; you must reinstall using the administrative image.

Administrative image and server products
Create or update an administrative image or install administrative server products on this
computer.

You can use an administrative image to install on multiple computers. For details about
installing SolidWorks on multiple clients using administrative images, see Using
Administrative Images on page 14.

When creating or updating administrative images:

• You can use installation settings from an existing image to configure the new or updated
image, or you can use the default SolidWorks installations settings.

• If you are updating an existing image:

• Installation Manager creates a new copy of the image, even if you are updating. The
original image is not modified.

• You can create the updated image using files from the existing image you are
updating. This results in a smaller download.

If you do not specify an image for which a Service Pack release is available to
update the previous image, you cannot take advantage of the smaller download.

SolidWorks administrative server products include SolidWorks Workgroup PDM Server
(Vault) and SolidNetWork License Manager. For details about these products, see
Workgroup PDM on page 49 and Administering Licenses Using a SolidNetWork License
Manager on page 56.

Download only
Download the installation files for selected SolidWorks products without installing the
products.

This option does not appear if you are installing from a DVD.

The content of the downloaded files is the same as the files that are available on the
SolidWorks installation DVD. Selecting this option downloads the full set of installation
files, regardless of what files might already be installed on your computer.

You can use this method to set up a server from which your users can perform installations.
This is different from creating an administrative image.

88



Installing and Managing Multiple Computers
The SolidWorks Installation Manager provides the following tools to install and manage
multiple SolidWorks computers.

SolidWorks Administrative Images
If you are installing SolidWorks on multiple computers, you can create an administrative
image and then deploy the application to other computers.

Workgroup PDM Server
The Workgroup PDM application is project data management software that runs inside
the SolidWorks environment or as a standalone application inside SolidWorks Explorer.
Workgroup PDM controls projects with procedures for check out, check in, revision control,
and other administration tasks. Installing the Workgroup PDM Server creates a Workgroup
PDM vault, which is the database that stores the managed SolidWorks projects.

SolidNetWork License Manager
The SolidNetWork License Manager allows the number of users to exceed the number of
licenses by floating the use of licenses. When a client license is not in use, it is available
for another SolidWorks user.

You can also use the SolidNetWork License Manager to distribute licenses for SolidWorks
core add-in products (for example, FeatureWorks).

Manual Download
You have chosen to download files manually (or you might have chosen to download
manually the last time you ran SolidWorks Installation Manager).

Click the link to open an automatically generated Web page that contains a complete list
of the files you need to complete your download.

You must download to the folder specified on the Summary page. Installation cannot
begin until all the files are downloaded into that folder.

Once you have completed the manual downloads, click Next to continue.

If you want to download automatically, you can change the option by going back to the
Summary Page and changing Download Options.

Newer Version Available
The Installation Manager has detected a newer version of SolidWorks products. You can
choose to install the version contained in the original installation DVD or download, or
you can choose to download and install the newer version.

If You Are Installing from a DVD
Under Would you like to use the newer version?, choose one of the following:

• No, continue installing version from this DVD. You can update afterwards with
a smaller download.

Select this option to continue with the installation using the current Installation Manager.

89



After the installation completes, you can check for and install updates using the
Installation Manager. To check for updates, run Start > SolidWorks Installation
Manager > Check for Updates.

The advantage is that this results in a smaller download. The disadvantages are that
this is a two-step process and the files that you download are version specific (and
cannot be shared by other users using different versions).

• Yes, perform installation using this DVD, then download and update to version.

Select this option to download and run a later version of the Installation Manager to
install SolidWorks products for that version.

If a small Service Pack release is available to update the DVD version, Installation
Manager first will install the original version from the DVD and then apply the Service
Pack update. This results in a smaller download.

You can achieve the same result by selecting the option to continue installing from the
DVD and then applying the update at a later date.

The advantage of this option is that it is a one-step process.

In most cases, installing the full version from the DVD and then using the Installation
Manager to check for and install updates is preferred because it requires smaller
downloads.

If You Are Installing from a Download
Choose one of the following:

• Continue installing version.

Select this option to continue installing the version contained in the initial download.

• Download and install a new version: version

Select this option to download the new version and install that. If there are multiple
new versions available, you can select the version to download and install.

No New Versions Available
There are no newer versions available for download. Proceed with installing the specified
version.

To proceed with the installation, click Next.

Processes Detected
Installation Manager has detected processes on this computer that might prevent a
successful installation.

• To continue the installation do one of the following:

• Close these processes (for example, using Microsoft Windows Task Manager) and
then press Retry.

• Click Ignore to proceed without closing the processes.

• To stop the installation, press Cancel.
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Product Selection
Specify the product components to install, modify, download, or remove.

In the product listing:

• The product listing is the complete listing of products that are available in the package
specified above the product listing.

• Products that contain additional components are annotated with +. To view all
components, click + to expand the listing for that component.

• To specify that a product component is to be processed, select the checkbox to the left
of the component.

• If you click on a product component, the status bar underneath the product listing lists
the action currently specified for that component.

• If you are performing a Modify installation, an asterisk (*) appears to the left of
components when you make any change in the product selection.

If you are applying a Service Pack, features of SolidWorks such as PhotoWorks and
FeatureWorks appearing under SolidWorks cannot be selected. This is because you cannot
add or remove a feature when performing this type of upgrade.

The actions performed by the Installation Manager are controlled by a set of product
coexistence rules.

Installation Manager selects these product components by default:

• If you are performing an upgrade or a Service Pack update, Installation Manager
selects the products currently installed.

• Otherwise, Installation Manager selects all products to which you are entitled.

To reduce your installation or download time and disk space requirements, expand
the product components and clear the check box for those components you do not
need.

If the Installation Manager was unable to verify the products to which you are
entitled, you can click Select different packages or products to change the
product package (such as SolidWorks Professional or SolidWorks Premium) listing
to install or modify. The Installation Manager lists all SolidWorks products on your
installation media that are compatible with the package you select. You can select
any products you purchased or are entitled to evaluate.

SolidWorks Search
SolidWorks Search provides a powerful full text search of SolidWorks documents, the
Workgroup PDM vault, and 3D ContentCentral. Search displays a preview and the file
location and name.

After the installation, SolidWorks Search indexes SolidWorks documents for faster searches.
Only SolidWorks files are indexed by default.

Installing SolidWorks Search automatically installs Windows Desktop Search if it is
not already installed on your computer.

Language Support
Expand the SolidWorks product and the Languages component to see the languages
you can install.
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Space Needed
The Installation Manager reports either total installation size or total download size at
the bottom of the page.

• If you selected the Download Only option, download size appears. Download size
is the total amount of disk space required for all of the downloaded files (not including
extra space required to unzip the files after the download completes). This figure is an
estimate.

All files needed for installation are included in the total download size. If some
files already were downloaded into the current download folder, they will not be
downloaded again. As a result, your actual download size might be smaller than
the total download size shown, or you might not need to download any files.

• Otherwise, installation size appears. Installation size is the change in disk space
usage that will occur when you complete this installation. Due to file compression,
these figures are estimates.

If you are upgrading or removing an existing installation, the installation size could be
zero.

The figure shown does not include any space needed to download or extract files if
required for the installation.

If downloads are required and you are downloading to the same drive, the actual
disk space requirements could be significantly greater than the installation size
that appears.

To reduce download or installation time for future modifications, do not delete
the downloaded files after installation. Subsequent updates and patches typically
require access to the last full installation file set.

Products to Download
Select SolidWorks products to download to a specified location.

The products available for download are determined by the serial number you supplied:

• The action to be performed for each component appears to the right of each item.
• Products that contain additional components are marked with a +. To view all
components, expand those products.

• Click the icon to the left of each component to select how it is handled by the Installation
Manager.

The Installation Manager downloads all product components to which you are entitled,
unless you specify otherwise. To reduce your download time and disk space
requirements, expand the product components and specify Do not download for
those components you do not need.

If the Installation Manager was unable to verify the products to which you are entitled,
you can select a SolidWorks package to download. The Installation Manager lists all
SolidWorks products that are compatible with the package you select.

If the Installation Manager was unable to verify the products to which you are entitled,
you can click Select different packages or products to change the product package
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(such as SolidWorks Professional or SolidWorks Premium) listing to install or modify.
The Installation Manager lists all SolidWorks products on your installation media that
are compatible with the package you select. You can select any products you purchased
or are entitled to evaluate.

Language Support
Expand the SolidWorks product and the Languages component to see the languages
you can install.

Space Needed
Based on the products you select, the space needed to perform the download is shown.
Download size is the total amount of disk space required for all of the downloaded files
(not including extra space required to unzip the files after the download completes). This
figure is an estimate.

To reduce download or installation time for future updates and patches, do not delete
the downloaded files after installation. Subsequent updates and patches typically
require access to the last full installation file set.

Products to Repair
When you specify Repair this installation, this screen displays the SolidWorks products,
with version numbers, that can be repaired by this Installation Manager.

Repair verifies that all the files are present and registered properly and fixes any problems
that are found. Data you have created is not affected.

• To repair a product, ensure that it is selected.
• Clear the check boxes for products you do not want to repair.

Click Repair to begin repairing the selected products.

You can repair an individual installation. You cannot repair an administrative image
installation; you must reinstall the administrative image.

Serial Number
Serial numbers, found on the distribution box, associate your computer with the SolidWorks
products you have purchased.

If SolidWorks products are already installed on your computer, their serial numbers are
displayed by default.

• Enter your SolidWorks serial number if it is not already displayed.
• If you have serial numbers for products that are not included with your SolidWorks
license, click the product entry underneath Do You Have Other Serial Numbers?
and then enter the serial number for that product.

If you have an internet connection, the serial numbers you provide will determine the
products to which you are entitled as you continue through the installation process.

Because there are multiple ways to purchase SolidWorks products, some serial
numbers can cover two or more products. For example, a SolidWorks serial number
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might enable you to install SolidWorks Simulation without entering a separate
SolidWorks Simulation serial number. In addition, some products do not require a
serial number. If you have any questions about your serial numbers, contact your
VAR.

Server Installation
The server products you are attempting to install are listed, with the results of the
installations.

Server Installation Status
Server product installations are performed by an external installation application. If you
are not currently in that application, you must switch to it to complete the installation.

Click Cancel to stop the server product installations.

Server Installation Complete
The external installation application has completed successfully.

Click Finish or Next.

• If you are installing other administrative products (for example, a SolidWorks
administrative image), that installation continues.

• If the server product installations were the only installation operation, Installation
Manager closes.

Server Installation Cancelled or Failed
If a server product installation failed or was cancelled after it was begun, servers that
were not installed are listed.

Click Close or Next.

• If you specified other administrative product installations, Installation Manager will
resume.

• If the server product installations were the only installation operation, Installation
Manager closes.

Summary
The SolidWorks Installation Manager has all of the information needed to complete the
installation operation.
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Click the action Now button to initiate the installation operation
(for example, Install Now, Create Now, Download Now,
Modify Now).

To continue:

Click CHANGE for the section you want to change (for
example, Products, Installation Location, Toolbox Options).

To change installation
settings:

Click Cancel to exit the Installation Manager without changing
installation components.

To cancel:

Click Back to return to a previous page in the Installation
Manager.

To revert to a previous
page:

For information about a particular set of installation options (for example, Products,
Installation Location, Toolbox Options, and so on):

1. Click CHANGE next to the section for which you want information.

2. In the detail page that appears, click Help to get information about those
installation option settings.

System Check Warnings
Installation manager system check reported issues that could impact how you continue
with the installation. In most cases, you should be able to proceed with the Installation
Manager.

Toolbox Options
If SolidWorks Toolbox is installed, SolidWorks includes a standard library of hole types
and hardware.

For details about configuring, extending, and using SolidWorks Toolbox, click Help >
Toolbox Help in SolidWorks.

To view this help, you might have to start the Toolbox add-in, using Tools >
Add-Ins.

Before using a SolidWorks Toolbox, make sure it is properly configured according to your
company or group policy. In many cases, a group will configure and maintain a central
Toolbox. Check with the SolidWorks administrator for guidance on how to specify a Toolbox
during SolidWorks installation.

You can change the selected SolidWorks Toolbox after installation. In SolidWorks, click
Tools > Options. On the System Options tab, click Hole Wizard/Toolbox.

The following sections describe all options you can encounter on this screen for all
configurations. The actual Toolbox options you see depends on the pre-existing SolidWorks
and Toolbox configurations on this computer and the Installation Manager choices you
have specified to this point.
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Create a new new-version Toolbox
Create a new version of SolidWorks Toolbox on this computer.

Any existing Toolboxes on this computer are not modified.

This option appears in all installation scenarios except creating an administrative image.

Reference or upgrade an existing Toolbox
Use an existing Toolbox. Click Browse to specify the location of the Toolbox you want
to use with this installation.

• If the Toolbox is configured for a previous SolidWorks major release version, it is
upgraded to this version. Any customizations made to that Toolbox are preserved in
the upgraded Toolbox.

Upgrading a Toolbox to a new SolidWorks major release version makes that Toolbox
incompatible with computers running prior major release SolidWorks versions.

• If the Toolbox is configured for this SolidWorks version (as might be the case if you
specify a shared network Toolbox that has already been upgraded), no upgrade to that
Toolbox occurs.

• If you are upgrading a Toolbox in an Enterprise PDM environment, additional procedures
are required. For details, see Upgrading Toolbox in a SolidWorks Enterprise PDM
Environment on page 98.

This option appears in all installation scenarios except creating an administrative image.

Upgrade a previous-version Toolbox
Copy a Toolbox configured for a previous major release version to a new location and
upgrade that copy to this version.

This option appears if a previous SolidWorks major release version is installed on this
computer, but you have chosen not to upgrade that installation to this release.

The purpose of this option is to upgrade a Toolbox for a previous major release
SolidWorks version that is installed without impacting users that are using the older
version of Toolbox.

If you are upgrading a Toolbox in an Enterprise PDM environment, additional procedures
are required. For details, see Upgrading Toolbox in a SolidWorks Enterprise PDM
Environment on page 98.

Upgrade this installed previous-version Toolbox
Upgrade this Toolbox to the newer version.

Upgrading a Toolbox to a new SolidWorks major release version makes that Toolbox
incompatible with computers running prior major release SolidWorks versions.

This option appears if you are upgrading a previous SolidWorks major release version to
this version and a Toolbox configured for that release is found on this computer.

If you are upgrading a Toolbox in an Enterprise PDM environment, additional procedures
are required. For details, see Upgrading Toolbox in a SolidWorks Enterprise PDM
Environment on page 98.
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Use the installed current-version Toolbox
Installation Manager has detected on this computer a Toolbox configured for this
SolidWorks major release version.

If you select this option, SolidWorks will use this Toolbox. No upgrade occurs.

This option appears if a previous SolidWorks major release version is installed on this
computer, but a Toolbox is configured for this version. This might occur if a shared Toolbox
is created on a computer that is still running an older SolidWorks version.

Specify the Toolbox location for the client computer
Specify a network or directory location as the default Toolbox location when clients install
from an administrative image.

If the location contains a Toolbox configured for a previous SolidWorks major release
version at the time the client installation occurs, Installation Manager upgrades that
Toolbox.

This option appears when you are creating a new administrative image.

Upgrade or use the Toolbox referenced in the existing image for
the client computer
Use the Toolbox location specified in an existing administrative image you are updating.

If the location contains a Toolbox configured for a previous SolidWorks major release
version at the time the client installation occurs, Installation Manager upgrades that
Toolbox.

Select a different Toolbox location for the client computer
Specify a different Toolbox location from that specified in an existing administrative image
you are updating.

If the location contains a Toolbox configured for a previous SolidWorks major release
version at the time the client installation occurs, Installation Manager upgrades that
Toolbox.

Notes About Configuring SolidWorks Toolbox
SolidWorks Toolbox is a powerful and complex feature. This topic summarizes some
concepts to consider before configuring a Toolbox using SolidWorks Installation Manager.

Finding More Information About SolidWorks Toolbox
For details about configuring, extending, and using SolidWorks Toolbox, click Help >
Toolbox Help in SolidWorks.

To view this help, you might have to start the Toolbox add-in, using Tools >
Add-Ins.
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Using a Shared Toolbox
When you install Toolbox, you can have Toolbox data on the local computer or in a shared
network location. Storing Toolbox data in a network location is recommended. By using
a common location, all SolidWorks users share a consistent set of fastener information.

If this is the first time installing, browse to the new shared location where you would like
to install the Toolbox.

Upgrading an Existing Toolbox
Upgrading a Toolbox to a new SolidWorks major release version makes that Toolbox
incompatible with computers running prior major release SolidWorks versions.

If other computers remain at that prior major release and continue to require a Toolbox
configured for that release, you should make a copy of that Toolbox and upgrade that
copy. The new SolidWorks installation will upgrade the copy of the Toolbox and the
previous SolidWorks installations will continue using the old Toolbox.

Configuring Toolbox Access
After installation, when you access Toolbox components SolidWorks checks how you have
configured Toolbox and makes suggestions to improve access and performance.

For accessing the shared network Toolbox (recommended), use a UNC path to the server
on which the shared Toolbox was installed.

An administrator can create a password for Toolbox and set permissions and preferences
for the workgroup. Restricting access to configuration and setting common preferences
ensures consistent Toolbox data.

Upgrading Toolbox in a SolidWorks Enterprise PDM Environment
Before you upgrade the first SolidWorks installation that accesses the Toolbox database
in an Enterprise PDM vault:

1. In Windows Explorer, navigate to the Toolbox folder in the Enterprise PDM vault.
2. Right-click the Toolbox folder and click Get Latest Version.

This enables the Installation Manager to verify whether parts need to be updated.

3. Check out the SWBrowser.mdb Toolbox database file from:

Vault\Toolbox_folder\lang\Language

The database file must be checked out so SolidWorks Installation Manager can update
the Toolbox.

4. After upgrading, check in the Toolbox folder to check in the database file and any new
Toolbox parts.

The Toolbox library in the vault has now been upgraded.

For subsequent SolidWorks upgrades, before initiating the upgrade, Enterprise PDM clients
must get the latest version of the vault Toolbox folder (using Get Latest Version). This
enables Installation Manager to verify that the files are up to date.

For details about Toolbox configuration in SolidWorks Enterprise PDM, see Configuring
Toolbox in the SolidWorks Enterprise PDM Administration Tool help.
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UNC Format
Uniform (or Universal) Naming Convention format specifies a file name syntax format to
describe a shared file location.

\\server\volume\path

For example:

\\Disk_Server\SolidWorks\AdminImage

Uninstall Products
When you select Remove from the Add or Remove Programs list, this screen displays
the SolidWorks products (with version numbers) that can be uninstalled by this Installation
Manager.

Select the SolidWorks products to uninstall. By default, all SolidWorks products for the
selected release are specified for uninstall.

• To uninstall a product, ensure that it is selected.

If you uninstall all products, the Installation Manager is also uninstalled.

• To retain a product, clear its check box.

If you retain any product, the Installation Manager is not removed from the Control
Panel Add or Remove Programs list.

To remove the selected products, click Remove Items .

When you click Remove Items, Installation Manager starts removing products
immediately.
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Legal Notices
© 1995-2009, Dassault Systèmes SolidWorks Corporation, a Dassault Systèmes S.A.
company, 300 Baker Avenue, Concord, Mass. 01742 USA. All Rights Reserved.

The information and the software discussed in this document are subject to change without
notice and are not commitments by Dassault Systèmes SolidWorks Corporation (DS
SolidWorks).

No material may be reproduced or transmitted in any form or by any means, electronic
or mechanical, for any purpose without the express written permission of DS SolidWorks.

The software discussed in this document is furnished under a license and may be used
or copied only in accordance with the terms of this license. All warranties given by DS
SolidWorks as to the software and documentation are set forth in the SolidWorks
Corporation License and Subscription Service Agreement, and nothing stated in, or implied
by, this document or its contents shall be considered or deemed a modification or
amendment of such warranties.

Patent Notices for SolidWorks Standard, Premium, and Professional
Products
U.S. Patents 5,815,154; 6,219,049; 6,219,055; 6,603,486; 6,611,725; 6,844,877;
6,898,560; 6,906,712; 7,079,990; 7,184,044; 7,477,262; 7,502,027; 7,558,705;
7,571,079, and foreign patents, (e.g., EP 1,116,190 and JP 3,517,643). U.S. and foreign
patents pending.

Trademarks and Other Notices for All SolidWorks Products
SolidWorks, 3D PartStream.NET, 3D ContentCentral, DWGeditor, PDMWorks, eDrawings,
and the eDrawings logo are registered trademarks and FeatureManager is a jointly owned
registered trademark of DS SolidWorks.

SolidWorks Enterprise PDM, SolidWorks Simulation, SolidWorks Flow Simulation, and
SolidWorks 2010 are product names of DS SolidWorks.

CircuitWorks, DWGgateway, DWGseries, Feature Palette, FloXpress, PhotoWorks,
TolAnalyst, and XchangeWorks are trademarks of DS SolidWorks.

FeatureWorks is a registered trademark of Geometric Ltd.

Other brand or product names are trademarks or registered trademarks of their respective
holders.

COMMERCIAL COMPUTER SOFTWARE - PROPRIETARY

U.S. Government Restricted Rights. Use, duplication, or disclosure by the government is
subject to restrictions as set forth in FAR 52.227-19 (Commercial Computer Software -
Restricted Rights), DFARS 227.7202 (Commercial Computer Software and Commercial
Computer Software Documentation), and in the license agreement, as applicable.

Contractor/Manufacturer:

Dassault Systèmes SolidWorks Corporation, 300 Baker Avenue, Concord, Massachusetts
01742 USA
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Copyright Notices for SolidWorks Standard, Premium, and
Professional Products
Portions of this software © 1990-2009 Siemens Product Lifecycle Management Software
III (GB) Ltd.

Portions of this software © 1998-2009 Geometric Ltd.

Portions of this software © 1986-2009 mental images GmbH & Co. KG.

Portions of this software © 1996-2009 Microsoft Corporation. All rights reserved.

Portions of this software © 2000-2009 Tech Soft 3D.

Portions of this software © 1998-2009 3Dconnexion.

This software is based in part on the work of the Independent JPEG Group. All Rights
Reserved.

Portions of this software incorporate PhysX™ by NVIDIA 2006-2009.

Portions of this software are copyrighted by and are the property of UGS Corp. © 2009.

Portions of this software © 2001 - 2009 Luxology, Inc. All Rights Reserved, Patents Pending.

Portions of this software © 2007 - 2009 DriveWorks Ltd.

Copyright 1984-2009 Adobe Systems Inc. and its licensors. All rights reserved. Protected
by U.S. Patents 5,929,866; 5,943,063; 6,289,364; 6,563,502; 6,639,593; 6,754,382;
Patents Pending.

Adobe, the Adobe logo, Acrobat, the Adobe PDF logo, Distiller and Reader are registered
trademarks or trademarks of Adobe Systems Inc. in the U.S. and other countries.

For more copyright information, in SolidWorks see Help > About SolidWorks.

Other portions of SolidWorks 2010 are licensed from DS SolidWorks licensors.

Copyright Notices for SolidWorks Simulation
Portions of this software © 2008 Solversoft Corporation.

PCGLSS © 1992-2007 Computational Applications and System Integration, Inc. All rights
reserved.

Portions of this product are distributed under license from DC Micro Development,
Copyright © 1994-2005 DC Micro Development, Inc. All rights reserved.
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